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Uvod T

Trajanje
Na ovome tecaju polaznik se upoznaje s osnovnim mogucnostima poglavlja:
programa za snimanje i obradu videosadrZaja. Za snimanje sucelja
ekrana i snimanje videa web-kamerom koristi se besplatan program 10 min
OBS Studio, a za obradu videosadrzaja koristi se besplatni program
Shotcut.

Tecaj je namijenjen pocetnicima i onima koji imaju malo iskustva u radu
S programima za snimanje i obradu videosadrzaja odnosno onima koji
zele dodatno utvrditi svoje znanje.

Polaznik ¢e na te€aju nauciti:

samostalno izradivati kompletne videosadrzaje
- konfigurirati program za snimanje

- postavljati efekte, prijelaze, filtre

- podeSavati zvuk

- obradivati videosadrzaje

- uvoziti i izvoziti videosadrzaj u Zeljenom formatu
- koristiti animacije, vizualne efekte

- objavljivati videosadrzaj.

Polaznici ¢e samostalno snimiti su€elje ekrana, sebe web-kamerom i
kombinacijom ostalih ponudenih videosadrzaja spoijiti sve u jedinstvenu
smislenu cjelinu koju ¢e, nakon obrade, mo¢i postaviti kao zaseban
videosadrzaj na YouTube ili bilo koju platformu koja podrzava
prikazivanje videosadrzaja.

Za oznacavanje vaznijih pojmova, naziva naredbi i elemenata sucelja te
naziva drugih elemenata koji se nalaze na ekranu koriste se podebljana
slova. Naziv pojedinog alata u priru¢niku naveden je u zagradi jer se do
toga imena dolazi dvostrukim pritiskom lijeve tipke miSa na ikonu alata u
Toolboxu tako da nije odmah vidljivo, a opis alata koji se pojavljuje
prelaskom pokazivaca preko ikone alata u Toolboxu podebljan je. Ispred
ili iza opisa i naziva alata nalazi se i prikaz ikone toga alata u Toolboxu

kao $to je navedeno u sljedeéem primjeru: Zoom in or out (Zoom) Q\ :
Put do naredbe pisan je kurzivom, a sama naredba podebljano,
primjerice Tools > Selection Tools > Rectangle Select.
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1. Upoznavanje radnoga prostora
programa OBS Studio

Po zavrSetku ovoga poglavija moci cete:
e instalirati i pokrenuti program OBS Studio
e prepoznati dijelove sucelja programa
e podesiti parametre prije pocetka snimanja
o prilagoditi podruéje pregleda sadrZaja
e jzabrati i stvoriti ispravan profil, temu ili jezik.

Open Broadcaster Software Studio (OBS Studio) jedan je od
najrelevantnijih besplatnih alata za streaming i snimanje sucelja
namijenjen za sve platforme. Pomoc¢u OBS Studija mogu se stvoriti
visokokvalitetni video streamovi za razli€ite web-usluge, moze se
zapoceti jednostavno emitiranje (engl. broadcast) te samostalno
snimanje web-kamerom i suCelja odjednom.

1.1. Pokretanje i upoznavanje radnoga prostora
OBS Studija

Nakon instalacije programa potrebno se upoznati s osnovnim alatima i
dijelovima sucelja OBS Studija. Kao i svaki drugi program, OBS Studio
ima specificne dijelove sucelja pomocu kojih se moze vrlo lako doéi do
zeljenih naredbi, alata i nekih drugih dodatnih opcija programa.

1.1.1. Instalacija OBS Studija i sustavi na kojima je dostupan

Instalacijsku datoteku potrebno je preuzeti sa stranice obsproject.com.
Odabere se poveznica ovisno o vrsti sustava te se nakon toga preuzme
instalacijska datoteka pritiskom na Download Installer.

Na donjoj slici prikazane su poveznice putem kojih je moguce preuzeti
instalacijsku datoteku za operacijske sustave Windows, Mac i
Gnu/Linux.

Download OBS Studio

Select Your Operating System

Ui

Prilikom odabira opcije Windows, ozna€ene crvenim okvirom na gornjoj
slici, moguce je joS odabrati dodatne opcije koje su prikazane na donjoj
slici. Prva opcija Download Installer podrazumijeva preuzimanje 64-

Trajanje
poglavlja:

60 min

Zanimljivosti i napomene

Najpoznatiji sustavi za koje
je dostupan program OBS
Studio: Windows 10,
Windows 8, Windows 8.1,
Mac OS X 10.13 i noviji,
Ubuntu 18.04 i noviji.

@ srce ’
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Zanimljivosti i napomene

Moguce je da program
prilikom instalacije zatrazi i
instalaciju dodatka pod
nazivom Microsoft Visual
C++ (obicno je to datoteka
VC redist x64.exe).

Za ispravan rad programa,
potrebno je instalirati i taj
dodatak pa tek nakon toga
OBS Studio.

bitne instalacije programa. Opcijom Download Installer (32-bit)
preuzima se instalacija za 32-bitne sustave. Jos je moguce preuzeti
instalacijsku datoteku koridtenjem dviju opcija: prva je putem
BitTorrenta, a druga u komprimiranom, ZIP obliku. Opcijom View on
GitHub moguce je vidjeti izvorni kdd programa. Moguce je i preuzeti
inacicu programa za korisnike koji imaju odgovarajucu vrstu znanja i
voljni su razvijati program. Zadnja opcija Previous Releases
omogucava pregled i preuzimanje prethodnih verzija programa. Uvijek je
najbolje preuzeti najnoviju, testiranu verziju programa.

Version: 29.1.3
Released: June 19th

Download Installer
Download via Bittorrent

Download Zip

. Get it from
B Microsoft
@ STEAM'

View on GitHub

Previous Releases

Nakon preuzimanja potrebno je pokrenuti datoteku i slijediti korake koji
se uglavnom sastoje od toga da se odabere Next te na kraju instalacije
Finish.

1.1.2. Pokretanje OBS Studija

Za pokretanje programa u sustavu Windows, odabere se Start > Sve
aplikacije > OBS Studio - OBS Studio. Prilikom prvoga pokretanja
program Ce se sporije otvarati jer pode$ava razne opcije, ali ve¢ drugi i
svaki sljedeci put pokretanje e biti puno brze.

Za pokretanje OBS Studija na Linux sustavima pritisne se na
Applications - Graphics > OBS Studio.

Za pokretanje na Mac sustavima potrebno je odabrati mapu
Applications te potom OBS Studio.
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1.1.3. Automatsko podeSavanje programa prema zeljenim
kriterijima

Prilikom prvog pokretanja programa pojavit ¢e se pomo¢ pri

podesavanju opcija programa u obliku Auto-Configuration Wizarda, kao

Sto je prikazano na donjoj slici.

& Auto-Configuration Wizard »

Usage Information
Specify what you want to use the program for

The auto-configuration wizard will determine the best settings based
on your computer specs and Internet speed.

This can be run at any time by going to the Tools menu.

Next Cancel

Opcije koje se nude su: optimizacija programa prvenstveno za
streaming, optimizacija programa samo za snimanje bez streaminga i
optimizacija za uporabu virtualne kamere. Odabirom bilo koje od tih triju
ponudenih opcija Auto-Configuration Wizard ¢e postaviti program na
nacin da najbolje odgovara specifikacijama ra¢unala na kojem je
instaliran OBS Studio. Na gornjoj slici odabrana je druga opcija koja ¢e
optimizirati program samo za snimanje. Nakon odabira opcije pritisne se
Next.

U sljede¢em koraku odabire se Base (Canvas) Resolution kao §to je
prikazano na donjoj slici. Bitno je napomenuti da ova rezolucija
(razlucivost) ne treba biti ista kao i razlu€ivost u kojoj se planira snimati
videosadrzaij, ali je potrebno odabrati najve¢u u kojoj se planira snimati
videosadrzaj. Tako se, recimo, ovdje moze odabrati 1080p (1920 x
1080), a izlazna razluc€ivost snimljenog videosadrzaja moze biti i manja
od toga, primjerice 720p. Druga opcija koja se moze odabrati jest FPS
(engl. Frames Per Seconds). Vrijednost koja se prikazuje u ovoj opciji,
30 ili 60, oznadava broj kadrova u jednoj sekundi. Sto je veéi broj
kadrova, zavrsni ¢e videosadrzaj biti veci i obrnuto. U praksi se najvise
koristi 30 FPS-a, ali moze se odabrati i 60. Nakon odabira pritisne se
Next.

Zanimljivosti i napomene

Navedene postavke mogu
se i kasnije promijeniti u
opcijama programa (File >
Settings = Video).
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Zanimljivosti i napomene

Navedene postavke mogu
se i kasnije promijeniti u
opcijama programa (File =
Settings = Video).

@ Auto-Configuration Wizard %

Video Settings
Specify the video settings you would like to use

Base (Canvas) Resolution = Use Current (1920x1080) | 2

FPS  Either 60 or 30, but prefer 60 when possible

Back =4 Cancel

U sljede¢em koraku potrebno je samo pri¢ekati da program automatski
testira sve moguénosti i navede preporuke.

Zavr$ni rezultat testiranja jest preporuka programa za koristenje najboljih
opcija snimanja videosadrZaja na tom ra¢unalu. U vecini slu€ajeva to su
i najbolje opcije koje se mogu samo potvrditi pritiskom na Apply
Settings, a ako se Zeli promijeniti neka od tih opcija, moguce je to
izvesti i kasnije u opcijama programa.

Za povratak na neki od prethodnih koraka potrebno je odabrati Back, a
ako se postavke koje je ponudio Auto-Configuration Wizard ne zele
primijeniti na program, potrebno je samo pritisnuti Cancel.

@ Auto-Configuration Wizard *

Final Results
Testing complete

n has determined that these estimated settings are the most

H.264)

dium File Size

Back Apply Settings Cancel
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1.1.4. Upoznavanje sa suceljem programa

Kada se otvori OBS Studio, prikazuje se sredisniji veliki radni prozor
ispod kojega se nalaze dijaloski okviri s razli€itim opcijama, a na vrhu je
izbornik.

Izgled sucelja i polozaj dijaloskih okvira moguée je promijeniti
premjestanjem dijaloskih okvira metodom ,povuci i ispusti®. Kada se
razmjeste, moguce ih je zaklju€ati putem izbornika Docks - Lock UL.
Nakon odabira ove naredbe dijaloSki okviri vise se ne mogu pomaknuti
sve dok se ponovno ne odabere ista naredba kojom se iskljuCuje
zaklju€avanje dijaloskih okvira.

Ako se zele vratiti razmjeSteni dijaloski okviri u poCetno stanje, moguce
je odabrati naredbu View - Reset Ul kojom Ce se svi dijaloSki okuviri
resetirati, tj. postaviti na poziciju na kojoj su bili prilikom instalacije
programa.

Prilikom pokretanja programa OBS Studija moze se primijetiti korisni¢ko
sucelje koje je podijeljeno u sedam sekcija kao $to je i prikazano na
donjoj slici:

o ®

1. Menu Bar ili glavni izbornik — sadrzi glavne padajuée
podizbornike putem kojih je moguce doci do svih dodatnih
funkcija u programu

2. Canvas Preview — podrucje pregleda gdje u stvarnom vremenu
mozete pogledati sve promjene koje su izvrSene u sceni

3. Source Toolbar — omogucuje brz pristup dodatnim opcijama bilo
kojeg uklju€enog izvora
4. Scenes - Cesto zanemarena opcija, iako je jedna od

najjednostavnijih funkcija koja pojednostavljuje neke opcije u
OBS Studiju; korisno je dodati scene prilikom nekog stati¢kog

@ srce ’
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1.1.5.

elementa u videosadrzaju, koje Ce biti uvijek na istoj poziciji bez
obzira na broj dodanih izvora

Sources — izvori koji se mogu dodavati na scenu; ima ih viSe od
10, mogu se grupirati i potrebno je odabrati jedan od njih prije
pocetka snimanja

Audio Mixer — omogucuje pregled i dodatne opcije zvuka i
prilikom snimanja i na snimljenom sadrzaju

Scene Transitions — opcije prijelaza izmedu scena u OBS
Studiju

Controls — sadrzi tipke za snimanje i streamanje videosadrzaja,
mogucnost prelaska u Studio Mode radi lak§eg obradivanja
videosadrzaja, Settings za lakSi pristup dodatnim opcijama
programa i Exit za izlazak iz programa.

Prilagodba programa

Postavke programa moguce je prilagoditi putem izbornika File >
Settings. Otvara se sko¢ni prozor Settings u kojemu korisnik moze
promijeniti gotovo sve postavke.

@ Settings

£} Genera

General

e Yami(Default)

rtup

reen capture

Updates

ility
Update Channel  Stable - Latast s

¢ Advanced

Output

Source Alignment Snapping

[ Enable

oK Cancel Apply

U izborniku General, podrucju General, moguce je promijeniti postavke
vezane za prikaz u programu. Tako je moguce odabrati zeljeni jezik
programa, temu, provjeru novih verzija programa prilikom otvaranja
programa i drugo. Za promjenu jezika programa potrebno je pritisnuti na
padajuci izbornik pokraj mogucnosti Language te odabrati Zeljeni jezik.
Kako bi se promijenio jezik, treba zatvoriti program i ponovno ga
pokrenuti, kao Sto je i navedeno u skocnom prozoru koji se pojavljuje
prilikom promjene jezika. Na gornjoj slici ta je moguc¢nost oznacena
crvenim okvirom. Hrvatski jezik podrzan je u programu, ali niz rijecCi nije
prevedeno, a neke se niti ne mogu odgovarajuce prevesti. Zbog toga,
kao i zbog Cinjenice da Ce se u sluéaju potrebe za dodatnim

@ srce
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informacijama o nekoj naredbi viSe informacija na internetu pronaci
upisom naredbe na engleskom nego na hrvatskom jeziku, u ovom tecaju
koristi se engleski jezik.

U izborniku Output, odjeljku Recording, moguce je dodatno odabrati
neke opcije snimanja. Opcijom Recording Path odabire se Zeljena
lokacija za pohranu videosadrzaja, a opcijom Recording Quality odabire
se kvaliteta zavrSnog videozapisa. Najbolji omjer kvalitete i veliine
datoteke dobiva se odabirom opcije High Quality, Medium File Size.

& Settings e

Software (x264)
(g Output

4 Audio Encoder Preset  veryfast (default) (medium CPU usage, standard quality)

Audio Encoder  AAC

Recording

. Advanced

out Space

at  Matroska Video (.mkv)
Video Encoder  Hardware (QSV, H.264)
Audio Encod
Audio Tra
Custom Muxer Settings

) Enable Replay Buffer

oK Cancel Apply

U polju Recording Format moze se odabrati format videosadrzaja,
preporuka je koristiti MKV zbog segmentnog nacina spremanja u taj
format, Sto znadi da, ako se dogodi prekid prilikom snimanja, u formatu
MKV nece se izgubiti cjelokupni snimljeni videosadrzaj. Nakon snimanja
videosadrzaja u formatu MKV potrebno je napraviti remux, tj. pretvorbu
iz formata MKV u MP4 koji je zastupljen na svim platformama. Nakon
zavrdetka snimanja odabire se opcija File > Remux Recordings koja
otvara skoCni prozor prikazan na donjoj slici.

Remux Recordings X
g

Drop files in this wi

Target File

“

Moguce je snimljenu MKV datoteku dodati metodom ,povuci i ispusti
(engl. drag and drop) ili odabrati tipku ... kako bi se ru€no potrazila

@ srce ’
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datoteka na raCunalu i dodala u Remux Recordings. Nakon dodavanja
datoteke potrebno je odabrati Remux i videosadrzaj ¢e se prebaciti i u
format MP4 i u istu mapu gdje se nalazi i MKV datoteka.

U izborniku Video moguce je dodatno podesiti rezoluciju snimanja i
izlaznu razluc€ivost videosadrzaja. Ru¢no se moze i podesiti FPS
vrijednost tako da se odabere jedna od ponudenih vrijednosti iz
padajuceg izbornika u opciji Common FPS Values.

@ Settings X

Gotovo sve bitne naredbe mogu se pokrenuti i putem tipkovnickih
pre€aca koji se unose u izborniku Hotkeys. Tako je moguée pokrenuti i
zaustaviti snimanje, pokrenuti i zaustaviti streamanje, promijeniti scenu
pomocu odredene tipke na tipkovnici ili poduzeti razne druge ponudene
naredbe.

1.2. Radno podruc¢je OBS Studija

Radno podrucje OBS Studija uredeno je tako da je fokus programa na
stvaranju i uredivanju kvalitetnih streamova i videosnimaka. Donji dio
sucelja sluzi za podeSavanje, upravljanje i korekciju videa, zvuka,
kamera, scena itd., dok je srediSnji dio namijenjen za pregled prilikom
snimanja ili za pripremu nove scene.

1.2.1. Priprema programa za snimanje

Prije samog poc&etka snimanja potrebno je pripremiti ,scenarij“: ako ne
na papiru, onda barem valja razmisliti $to se Zeli posti¢i snimljenim
videosadrzajem.

Snimanju se moze pristupiti na dva nacina. Jednostavniji nacin snimanja
podrazumijeva ukljuivanje web-kamere te npr. prezentacije ili neke
druge vrste dokumenta (PDF, Word, Excel ili slicno) nakon ¢ega se
moze krenuti sa snimanjem. To znaci da se pozicija web-kamere nece

10 @ srce
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mijenjati tijekom cijelog procesa snimanja videosadrzaja i da Ce se raditi
samo na dokumentu koji je pokrenut. To je standardan, zadani nacin
rada programa nakon njegova pokretanja, kao $to je i prikazano na
donjoj slici.

Prezentacija \

Ivan Horvat
Vaditel projekta

Drugi nac¢in snimanja malo je kompleksniji i podrazumijeva izradu scena
o kojima ¢e biti viSe rije€i u drugom poglavlju. Na slici dolje prikazan je
nacin snimanja videosadrzaja Studio (Studio Mode). U takvom nacinu
snimanja moguce je unaprijed pripremiti viSe razli¢itih prikaza te ih
ukljucivati prema potrebi. Na donjoj slici s desne je strane prikazana
jedna prezentacija u PowerPointu i prikaz web-kamere koja se nalazi u
donjem lijevom kutu. U bilo kojem trenutku moguce je prikazati i
kalendar u MS Wordu koji se nalazi s lijeve strane i kojemu je web-
kamera u donjem desnom kutu. Za takvo prebacivanje koriste se scene i
nacin rada Studio koji omogucuje uvid u scenu koja se planira prikazati.

Y ny

; Prezentacija \

1.2.2. Dodatne opcije za lakSe podesSavanje scene

Pritiskom desne tipke miSa u podrucju Canvas Preview pojavljuje se
dodatni opceniti izbornik u kojem se mogu odabrati neke standardne
opcije kao &to je i prikazano na donjoj slici. Tako se moze omoguciti
pregled sadrzaja na platnu, zaklju€ati sve izvore (web-kamera,
prezentacija, slika itd.) koji su postavljeni na podrucju ekrana tako da se
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ne mogu viSe pomicati, podesiti prikaz videosadrzaja ili dodati neki novi
izvor poput nove prezentacije, slike, web-stranice itd.

Windowed Pro

Screenshot (Preview)

Add

Nakon zavrSetka podeSavanja programa moguce je spremiti postavke
tog profila tako da mu se prvo promijeni ime preko izbornika Profile >
Rename. Nakon toga profil se moze izvesti naredbom Profile > Export,
a pritom se odabere mapa u koju se Zeli spremiti profil.

Za potpuno resetiranje programa, tj. postavljanje programa na pocetne
postavke Sto se tiCe profila i ostalih postavki, potrebno je odabrati
naredbu File > Show Settings Folder, zatvoriti OBS Studio i nakon
toga obrisati cjelokupan sadrzaj prikazane mape tako da ona ostane
prazna. Zatim je potrebno ponovno pokrenuti OBS Studio i ponoviti
postupak Auto-Configuration Wizarda. Nakon §to se program pokrene,
moguce je ranije izvezeni profil uvesti u program naredbom Profile >
Import, nakon ¢ega ¢e se primijeniti sve spremljene postavke profila.
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1.3. Vjezba: Upoznavanje radnoga prostora Zanimljivosti | napomens
1. Premijestite dijaloSki okvir Scenes iza dijaloskog okvira Prije premjestanja dijalogkih
Audio Mixer i zaklju€ajte dijaloSke okvire pomocu okvira potrebno je
naredbe Docks - Lock Docks. naredbom Docks > Lock
Ul provijeriti je liona
2. Postavite jezik na hrvatski i odaberite temu Accri u iskljuCena (nema kvacice
postavkama programa File - Settings > General. Nakon pored naredbe).

odabira zatvorite i ponovno pokrenite program ako je
program porukom to zatrazio od vas.

3. Vratite jezik na engleski jezik i postavite temu Dark. U
File > Settings > Output promijenite format snimanja
videosadrzaja u mp4 (Fragmented MP4). Nakon odabira
zatvorite i ponovno pokrenite program ako je program
porukom to zatrazio od vas.

4. Resetirajte program na pocCetne postavke putem izbornika
File > Show Settings Folder tako da obriSete
cjelokupan sadrzaj mape te nakon ponovnog pokretanja
OBS Studija ponovite postupak Auto-Configuration
Wizarda.
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2. Dodavanje izvora i kreiranje scena u e
OBS StUdljU Trajanje

poglavlja:

Po zavrsetku ovoga poglavlja moci cete: 70 min
e jzraditi novu scenu u programu OBS Studio
e na scenu dodati izvor ili vise njih
e podesiti izlazni videosadrZaj
e pozicionirati izvore po podrucju pregleda
e primijeniti prijelaze izmedu scena.

U ovom poglavlju prikazat ¢e se uredivanje prostora za snimanje tako da
sadrzi sve zeljene elemente na jednom ekranu. Osim postavljanja
elemenata na jednom ekranu, pristupit ¢e se i naprednoj izradi novih
scena i stavljanja dodatnih izvora na vise razli€itih scena, kao i efektnih
prijelaza izmedu tih scena.

2.1. Dodavanje izvora na scenu

Prije poCetka snimanja potrebno je ukljuciti sve elemente koji se zele
prikazati na ekranu. Za ukljucivanje, tj. prikaz zZeljenih elemenata na
sceni, a samim time i na zavrSnom videosadrzaju, potrebno je dodati
izvore (engl. sources).

Za dodavanije izvora na scenu potrebno je imati ukljucen dijaloski okvir
Sources, kao $to je prikazano na donjoj slici.

Sources

Obi¢no je ovaj dijaloski okvir automatski uklju¢en prilikom instalacije
OBS Studija, ali ako se iz nekog razloga ne pojavljuje, potrebno ga je
ruéno ukljuciti putem izbornika Docks > Sources.

Kao Sto i navodi tekst koji se nalazi unutar dijaloSkog okvira, za
dodavanije bilo kojeg izvora potrebno je pritisnuti tipku + ili unutar tog
dijaloSkog okvira pritisnuti desnu tipku miSa, opciju Add te odabrati
odgovarajuéi izvor.

Pritiskom na tipku + pojavit ¢e se svi ponudeni izvori koji se mogu
odabrati u programu, Sto se moZze vidjeti na slici koja slijedi. Tako se
moze ukljuciti dodatni mikrofon, zvuénik, prikazati zeljene web-stranice ili
live streaming, promijeniti boju pozadine, prikazati zaslon, prikazivati
igranje neke igre, ukljuciti sliku / fotografiju ili prezentaciju, prikazati neki
videosadrzaj, ukljuciti tekst ili web-kameru. Istovremeno se moze
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odabrati viSe izvora na jednoj sceni, §to je i uobi¢ajeno, tako da se
naj¢esce u jednostavnijem videozapisu prikazuje neka prezentacija,
slika ili dokument uz simultani prikaz web-kamere, tj. predavaca.

Application Audio Capture (BETA)

® Audio Input Capture

4)) Audio Output Capture

® Group

Deprecated

Za dodavanje web-kamere potrebno je prethodno ukljuditi / instalirati
web-kameru na ra¢unalu pa je tek nakon toga dodati u OBS Studio. Za
dodavanje web-kamere kao izvora potrebno je odabrati opciju Video
Capture Device koja je prikazana s crvenim okvirom na gornjoj slici.

Nakon odabira pojavljuje se dijaloski okvir Create/Select Source
prikazan na donjoj slici.

@& Create/Select Source x
O Create new
Video Capture DE‘\IiCE|

@ Add Existing

[¥] Make source visible

Cancel

Na raspolaganju su tri opcije. U prvoj opciji Create new stvara se novi
izvor i upisuje se njegov naziv. U ovom slu€aju moze se napisati da je
naziv Web-kamera zato jer se zeli prikazati web-kamera na sceni. Druga
opcija Add Existing odnosi se na ve¢ stvoreni izvor ukoliko postoji.
Koristenjem te opcije moze se odabrati neki ve¢ stvoreni izvor i izbjedi
dodatne postavke. Opcijom Make source visible moguce je izvor sakriti
ili ostaviti vidljivim nakon dodavanja na scenu.

Odabirom Create new i pritiskom na OK otvara se novi dijalo$ki okvir
Properties for '[naziv izvora]', prikazan na donjoj slici. Kako je naziv
izvora u prethodnom koraku bio naveden kao Web kamera, otvorio se
dijaloski okvir Properties for 'Web kamera'. Odabirom padajuceg
izbornika prve opcije Device ponudeni su svi uredaji koji odgovaraju
izvoru koji je odabran, u ovom slucaju videouredaji. Na primjeru koji
slijedi vidi se mogucnost odabira triju razli€itih uredaja, HP-ove web-
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kamere, Logitechove web-kamere i OBS-ove virtualne kamere. Nakon
odabira Zeljene kamere moguce je joS odabrati i postavke za tu kameru
ako postoji ta mogucnost. Tako se moze odabrati razlu€ivost kamere,
videoformat u kojem ¢e snimati, FPS i drugo.

@& Properties for "Web kamera' e

Pritiskom na OK potvrduje se odabir kamere sa zadanim postavkama te
se ona prikazuje na sceni. Na donjoj slici za primjer je odabrana OBS
Virtual Camera. Kamera se obi¢no maksimalno proSiri na sceni, pa je
potrebno prilagoditi njene dimenzije.

Ako se zeli smanijiti prikaz kamere i pozicionirati na neko odredeno
mjesto na sceni, potrebno se koristiti crvenim kvadrati¢ima na crvenom
okviru kamere. Za proporcionalno smanjivanje prozora kamere potrebno
se koristiti bilo kojim kvadrati¢ima na okviru. Pritisne se i drZi lijeva tipka
miSa na kvadrati¢u i prozor se povlaci miSem do Zeljene dimenzije.
Nakon zavrSetka otpusti se lijeva tipka miSa. Sada se prikaz kamere
smanjio na zeljenu dimenziju, a ako se zeli premijestiti taj prozor na neku
drugu poziciju na sceni, potrebno je unutar tog prozora pritisnuti i drzati
lijevu tipku miSa te pomicanjem miSa premijestiti prozor kamere na
Zeljenu poziciju na sceni. Na ovaj nacin prilagodava se dimenzija i
pozicija bilo kojeg izvora koji je umetnut na scenu.
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Zanimljivosti i napomene

Potrebno je razumijeti da sto
se viSe izvora ukljudi, to je
potrebno i jace racunalo.
Primjerice, ako se zeli
komentirati neki
videosadrzaj koiji ¢e biti
pokrenut preko cijelog
ekrana i na njemu ¢e biti
dodan izvor web-kamere
kao &to je dodan na
gornjem primjeru, kod
slabijih se raCunala prilikom
snimanja moze oc¢ekivati
zastajkivanje web-kamere.

Na slici koja slijedi vidi se smanjeni i premjesteni prikaz izvora Web
kamera na sceni. Ujedno je u dijaloSkom okviru Sources moguce vidjeti
naziv izvora Web kamera i pokraj naziva dvije ikonice. Pritiskom na prvu
ikonicu B moguce je sa scene sakriti odabrani izvor. Ova se moguénost
Cesto koristi kod dupliciranih scena (o ¢emu cCe biti rijeci kasnije), tako da
se u jednoj sceni, primjerice, vidi prezentacija i osoba na kameri, a druga
scena sadrzi samo prezentaciju, bez vidljivog izvora kamere, tj. osobe.
Druga ikonica B sluzi za zaklju¢avanje izvora tako da mu se ne moze
promijeniti dimenzije ni pozicija na sceni.

Sada je u izvorima dodana samo kamera, a uz nju se moze dodati jo$
mnogo razli€itih izvora koji se mogu i ne moraju prikazati na istoj sceni.
Za primjer Ce se dodati i prezentacija, sto je i najéesc¢i primjer nekog
videosadrzaja kojim se zeli prikazati neko predavanje. Prije dodavanja
prezentacije (PDF dokumenta, Word dokumenta ili sl.) u izvor, potrebno
ju je pokrenuti na racunalu. Nakon pokretanja prezentacije pritisne se na
+ i odabere opcija Window Capture. Potom se otvara dijaloski okvir
istovjetan onome kada se dodavala web-kamera u kojem je potrebno
upisati naziv izvora, u ovom slu€aju Prezentacija. Nakon pritiska na OK
pojavit ¢e se dijaloSki okvir naziva Properties for 'Prezentacija’ kao §to je
prikazano na donjoj slici.

& Properties for 'Prezentacije’ X

Prezentacija \\

W  [POWERPNT.EXE]: Prezentacija.pptx - Powerpoint

Capture Method  Automatic

Window Match Priority  Match title. otherwise find window of same type

Defaults OK Cancel

U opciji Window moguce je otvoriti padajuéi izbornik u kojem su
ponudene sve otvorene aplikacije, poput PowerPoint prezentacije, Word
dokumenta, PDF dokumenta, slike ili neke proizvoljne aplikacije koja se
zeli prikazati. Potrebno je odabrati zeljenu aplikaciju / datoteku koja se
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nakon odabira automatski prikazuje u sucelju dijaloSkog okvira. Nakon
Sto je odabrana zeljena datoteka, u gornjem slucaju prezentacija u
PowerPointu, potrebno je pritisnuti OK. Odabrana aplikacija ¢e se
prikazati kao poseban izvor u programu, kao $to je prikazano na donjoj
slici.

a - o x

Prezentacija \

Votsi projesta

Moze se vidjeti da su na sceni aktivna dva izvora, Prezentacija i Web
kamera, ali je prikazana samo prezentacija. Prilikom dodavanja izvora
na scenu on se automatski postavlja na najvidu razinu / u najvisi sloj,
kao $to je prikazano crvenim okvirom na gornjoj slici. Potrebno je
oznaditi izvor Prezentacija i metodom ,povuci i ispusti® prebaciti taj izvor
ispod izvora Web kamera, ili oznaciti izvor Prezentacija i pritisnuti Move
down (strelica dolje) u izborniku Sources kako bi se izvor premjestio
dolje. Sada se prezentacija nalazi ispod kamere i kamera je vidljiva na
sceni, $to se i vidi na donjoj slici.

2 - o =
=

Prezentacija \

Voditsl projesta

Bilo koji dodani izvor u izborniku Sources moguce je premjestati gore ili
dolje pomocu strelica tako da se stvori Zeljeni prikaz scene. Dvostrukim
pritiskom na Zeljeni izvor otvara se dijaloski okvir Properties for [ime
izvora], gdje je mogucée naknadno uci u opcije Zeljenog izvora ako je to
potrebno. Do istog izbornika dolazi se i odabirom Zeljenog izvora i
pritiskom na Ed Properties na dnu dijaloSkog okvira Sources. Kada se

Zanimljivosti i napomene

Izvori se mogu staviti i u
grupe tako da tehnicki
djeluju kao jedan izvor.
Oznace se zeljeni izvori,
pritisne se desna tipka misa
te se odabere opcija Group
Selected Items.

Grupa se mozZe razgrupirati,
tj. izvori se mogu vratiti u
pocetno stanje pritiskom
desne tipke miSa na grupu i
odabirom opcije Ungroup.

neki izvor Zeli obrisati, odabere se Zeljeni izvor pritiskom lijeve tipka miSa
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i pritisne Bl Remove u dijaloskom okviru Sources, ili se na tipkovnici
pritisne tipka [Delete] nakon odabira izvora koji se Zeli ukloniti.

Ako se prvo oznadi neki izvor na platnu, primjerice prezentacija, web-
kamera ili sl. i nakon toga se pritisne desna tipka miSa u podrucju
Canvas Preview, pojavljuje se dodatni, puno vedi izbornik od opéenitog
izbornika opisanog u prvom poglavlju (opceniti izbornik opisan u
poglaviju: 1.2.2. Dodatne opcije za lakSe podeSavanje scene).

Osim op¢enitih opcija, nude se i specificne opcije namijenjene za
konkretan izvor. Tako je moguée promijeniti boju izvora u Sources radi
lak$eg raspoznavanja tog izvora, preimenovati izvor, obrisati ga,
promijeniti razinu na kojoj ¢e se prikazivati, promijeniti mu veli€inu,
napraviti snimku ekrana (engl. screenshot) koja ¢e se spremiti u mapu
gdje se sprema i videosadrzaj, dodati filtre na izvor, prikazati
karakteristike ozna¢enog izvora i drugo.

2.1.1. Koristenje filtra

Na gornjoj slici moZe se uociti da se nakon ukljucivanja prezentacije i
kamere prezentacija ne vidi u dijaprojekciji (preko cijelog zaslona), ve¢ je
ona otvorena u radnom okruzenju. U vecini sluajeva Zeli se prikazati
prezentacija preko cijelog zaslona i na njoj manji prikaz web-kamere kao
na ranije prikazanoj slici. Takav prikaz mozZe se dobiti na dva nacina.

Prvi nacin je da se doda izvor Display Capture koji prenosi sve $to se
nalazi na zaslonu. Nakon toga pokrene se prezentacija preko cijelog
zaslona, a izvor web-kamere postavi se kao i u gornjem slucaju na prvo
mjesto. Nedostatak ovakvog nacina prikaza je $to predavac ne moze
vidjeti koji mu je sljededi slajd, nego kontrolira prezentaciju samo u
dijaprojekciji.
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Drugi je nacin koristenje izvora Windows Capture i web-kamere
podeSene kao i u gornjem primjeru, ali uz koristenje filtra. Filtri
omogucuju promjenu sadrzaja dodavanjem odredene komponente s
ciliem njegova poboljSanja. U ovom konkretnom primjeru primijenit ¢e se
filtar Crop/Pad kako bi se izrezao dio oko same prezentacije. Cilj
izrezivanja jest prikazivanje korisnicima samo zeljenog dijela PowerPoint
prezentacije, u gornjem slucaju to je samo podrucje programa u kojem
se nalazi slajd prezentacije. Korisnici ¢e i dalje vidjeti preko cijelog
zaslona prezentaciju, ali predava¢ ima moguénost odabira Zeljenog
slajda u programu s lijeve strane bez da to korisnici primijete.

Filtri se mogu primijeniti na bilo koji izvor tako da se odabere Zeljeni
izvor i pritisne na Filters u Source Toolbaru ili se pritisne desnom tipkom
misa na izvor i odabere opcija Filters. Nakon odabira otvorit ¢e se
dijaloSki okvir Filters for [ime izvora] gdje se pomocu tipke + mogu
odabrati ponudeni filtri, kao to je prikazano i na donjo;j slici.

Prezentacija \‘ r ‘

Vodiijprjekta

—4

Odabran je izvor Prezentacija jer se na njemu zeli primijeniti filtar
Crop/Pad. Za primjenu filtra dovoljno ga je samo odabrati s padajuceg
izbornika nakon ¢ega se otvara dijaloSki okvir u kojem je potrebno
napisati proizvoljno ime filtra ili ostaviti postoje¢e. Potvrdom na OK filtar
Crop/Pad pojavljuje se u podrudju Effect Filters s lijeve strane, a
njegove opcije prikazuju se ispod odabranog izvora kao $to je prikazano
na donjoj slici. Ovaj filtar ima polja za upis vrijednosti lijeve, desne,
gornje i donje strane. Na samom pocetku te vrijednosti postavljene su na
0, ali promjenom vrijednosti suzava se i prikaz koji ¢e se vidjeti na tom
izvoru. Osim direktnog upisa brojeva, moguce je podeSavati vrijednosti i
pomocu strelica gore i dolje E s desne strane opcija smjerova. Do to¢nih
vrijednosti dolazi se metodom isprobavanja jer svaki je izvor drugadiji i
svaki korisnik Zeli prikazati / izrezati nesto drugo. Prvo se upie neki broj
pa se vidi treba li povecati ili smanijiti vrijednost. Nakon upisivanja
vrijednosti za sve smjerove dolazi se do Zeljenog prikaza odredenog
izvora, kao $to je to prikazano na sljedecoj slici.
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Zanimljivosti i napomene

Radi $to vece kvalitetu
snimke potrebno je Sto je
vise moguce povecati
prikaz aplikacije koju se
snima (u naSem primjeru
PowerPoint). Najbolje bi bilo
preko cijelog zaslona, a ako
nam to mogucnosti ne
dozvoljavaju, onda $to je
viSe moguce.

Prezentacija \

Wan Horvat
Vodite] projekta

Moze se vidjeti da ¢e se od pokrenute PowerPoint aplikacije prikazati
samo dio koji se prikazuje i kod dijaprojekcije, a predavacu je ostala
mogucnost kontroliranja prijelaza na bilo koji slajd, bez da to vide
polaznici.

Na jedan izvor moze se dodati i vise filtara istim postupkom kao $to se
dodao i gore prikazani filtar. Za brisanje odredenog filtra potrebno je otici
u izbornik Filters for [ime izvora], odabrati filtar koji se Zeli obrisati te
pritisnuti na Remove B. Nakon zavrsetka u dijaloSkom okviru Filters for
[ime izvora] pritisne se Close.

Prezentacija \

pan Hervat
Vodel projekts

Na gornjoj slici paralelno se vidi otvorena prezentacija u PowerPointu i
ta ista prezentacija prikazana u OBS Studiju putem filtra Crop/Pad.
Sada se moze jasnije vidjeti da ¢e prilikom odabira slajdova u
PowerPointu OBS Studio prikazati prezentaciju kao da je u dijaprojekciji,
bez da se vidi ostali dio aplikacije PowerPoint. Upravo to se Zeljelo
posti¢i ovim filtrom.

2.1.2. Snimanje postavljene scene

Kada je kompletna scena postavljena, kada su dodani svi Zeljeni izvori i
kada su ti izvori postavljeni na Zeljene pozicije u sceni, moze se krenuti
sa snimanjem.
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Snimljeno ¢ée biti sve ono §to se nalazi i $to se vidi na podrucju pregleda
(Canvas Preview). Prije pokretanja snimanja moze se jo$ jednom u
opciji File > Settings - Output pod kategorijom Recording Path
provjeriti gdje Ce biti spremljen videosadrzaj i provjeriti ima li na tom
odredistu dovoljno prostora na disku. Ako nema, putanja se moze
promijeniti.

Pritiskom na Start Recording pokrece se snimanje. Trajanje snimanja
moze se vidjeti na dnu sucelja programa, u statusnoj je traci oznaceno
crvenim okvirom na donjoj slici.

Prezentacija \

Vodite] projekta

Prilikom snimanja OBS Studio mozZe se minimizirati tako da ne smeta u
izlaganju prilikom snimanja. U svakom trenutku moze se otvoriti i
provjeriti podrucje pregleda da bi se vidjelo kako Ce izgledati zavrSna
snimka. Tijekom snimanja moguce je bilo koji izvor sakriti ili otkriti
pomocu ikonice oka B u podrucju Sources. Tako se moze u nekom
trenutku ukloniti / sakriti web-kamera da se bolje vidi sadrZaj same
prezentacije i opet prikazati u bilo kojem drugom trenutku.

Za zavrSetak snimanja potrebno je samo odabrati Stop Recording i
video Ce se automatski spremiti na prethodno odabranu lokaciju.

Kao $to je vec objadnjeno u poglavlju 1.1., nakon zavrSetka snimanja
moze se odabrati opcija File > Remux Recordings koja otvara sko¢ni
prozor u kojem se odabire upravo snimljen videosadrzaj i pretvara u
format MP4 ako ima potrebe za tim. Nakon snimanja / spremanja,
videosadrzaj je spreman za objavu ili se moze jo§ dodatno uredivati u
nekom programu za obradu videosadrzaja poput Shotcuta.

Zanimljivosti i napomene

Prije snimanja korisno je
postaviti si tipkovnicke
pre€ace (engl. hotkeys) za
pokretanje i zaustavljanje
snimanja kao i za ostale,
Cesto koristene funkcije.
Pomocu njih je, primjerice,
moguce bez otvaranja
programa (ako je on
minimiziran) zaustaviti
snimanje u Zeljenom
trenutku.
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Zanimljivosti i napomene

Filtri se osim kod izvora

mogu Koristiti i na scenama.

Na odabranoj sceni pritisne
se desna tipka misa i
odabere naredba Filters.
Nakon toga filtar se
primjenjuje po istom
principu kao i za neki
prethodno opisan izvor.

2.2. Napredno snimanje sucelja u OBS Studiju

OBS Studio koristi scene za prikaz izlaznog videosadrzaja. Scena je
kombinacija videoslojeva gdje svaki sloj sadrzi jedan izvor. To znaci da
su razli¢ite vrste slojeva spojene u jednu scenu. Samo odabrana scena
se vidi na izlazu, tj. na snimljenom videosadrzaju. Tako se moze
pripremiti vise razli¢itih scena i prebacivati se izmedu njih tijekom
snimanja koriStenjem opcije koja se naziva prijelaz (engl. fransition).

2.2.1. Stvaranje nove scene

Nakon prvog pokretanja programa imenovana je prazna scena Scene
koja se pojavi u dijaloSkom okviru Scenes. Sadrzaja nema i popis izvora
je prazan. U prethodnim primjerima svi izvori dodavali su se samo na
jednu, poc€etnu scenu.

Nova scena moze se stvoriti u okviru Scenes - + ili u istom dijaloSkom
okviru pritiskom na desnu tipku miSa i odabirom naredbe Add. Pojavljuje
se dijaloski okvir Add Scene, prikazan na donjoj slici, u koji se upisuje
ime scene.

& Add Scene K

Nakon upisa imena potrebno je pritisnuti OK. Novonastala scena ¢e se
pojaviti na zadnjem mjestu u dijaloSkom okviru te ¢e se program
automatski pozicionirati u nju. Stvorena scena je prazna te je potrebno
dodati jedan ili viSe izvora na nju istom metodom kao i kod prve scene.
Ako se Zeli naknadno promijeniti naziv scene, potrebno je desnom
tipkom misa pritisnuti na scenu kojoj se zeli promijeniti ime te odabrati
naredbu Rename. Nakon upisa novog naziva pritisne se tipka [Enter] za
potvrdu.

U dijaloS8kom okviru Scenes moguce je prelaziti iz jedne scene u drugu
pritiskom lijeve tipke miSa na Zeljenu scenu. Scene su poredane jedna
ispod druge u List Modeu, a pritiskom desne tipke mi$a u dijaloSkom
okviru Scenes moguce je odabrati Grid Mode, gdje su scene poredane
u mrezu kao $to je i prikazano na donjoj slici.

Scenes 7 Sources

Prva scena Druga scena ™ Prezentacija_2

Scene mogu mijenjati svoj redoslijed kao i izvori, potrebno je samo
oznaciti scenu kojoj se Zeli promijeniti redoslijed te pritisnuti na tipku

za premjestanje odabrane scene gore i ili dolje M. Osim premjestanja
pomocu tipke moguce je to uraditi i metodom ,povuci i ispusti® (engl.
drag and drop).
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Pritiskom desne tipke miSa na scenu otvara se izbornik u kojem je
moguce odabrati dodatne opcije na odabranoj sceni kao $to je prikazano
na donjoj slici. Tako je moguce dodati novu scenu, duplicirati scenu,
kopirati sve filtre iz te scene i zalijepiti na neku novu scenu, preimenovati
scenu, obrisati je, promijeniti poredak.

Add

Duplicate

Rename

Remave

Order

Filters
No source sel
Transition Override
Scenes
ultiview

Moguce je i postaviti odabranu scenu na puni zaslon ili pustiti scenu na
puni zaslon nekog drugog monitora ili spojenog projektora. Takoder je
moguce napraviti snimku zaslona (engl. screenshot) ili promijeniti vrstu
prijelaza iz scene na scenu.

2.2.2. Studio Mode

Tijekom streaminga ili snimanja mogu se uredivati scene bez utjecaja na
izlazni videosadrzaj. Za takav nacin snimanja potrebno je u¢i u Studio
Mode koji se pokrece iz dijaloSkog okvira Controls.

Program: Prva scena

Nakon ukljucivanja podrucje pregleda dijeli se na dva zaslona:

e lijevi (Preview) — scena za uredivanije ili pregled

e desni (Program) - izlazni videosadrzaj koji se ne moze uredivati.
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Za bilo kakve promjene na sceni u ovom nacinu rada potrebno je
odabrati Zeljenu scenu iz dijaloSkog okvira Scenes i uredivati je na
liievom zaslonu. Kada se Zeli prikazati nova, uredena scena, potrebno je
samo odabrati Transition na sredini podrucja pregleda. Nakon pritiska
moze se vidjeti da su trenutna scena i novouredena scena zamijenile
mjesta, tako da je sada na izlaznom videosadrzaju prikazana uredena
scena.

Zamjena tih scena nije se dogodila brzo, naglo, ve¢ se postupno
prezentacija poCela prikazivati na izlaznom videosadrzaju. Za to je
zasluzan efekt prijelaza iz scene na scenu koji se odabire u dijaloSkom
okviru Scene Transitions, koji je prikazan na donjoj slici.

Scene Transitions

Fade

Duration 300 ms

Fade je naziv prijelaza izmedu scena, a pritiskom na strelicu & otvara se
padajuéi izbornik s moguénoséu odabira sedam razli¢itih tipova prijelaza.
Nakon odabira moguce je provijeriti prijelaz tako da se pritisne na
Transition, nakon Cega Ce se vidjeti kako radi odabrani tip prijelaza.
Ispod padajuéeg izbornika za odabir prijelaza nalazi se podrucje za upis
pod nazivom Duration, gdje se upisuje trajanje odabranog prijelaza iz
scene u scenu u milisekunda kao jedinicama.

Pritiskom na & u padaju¢em izborniku mozZe mu se dodati neki prijelaz s
prefiksom Add:. Ako se doda, primjerice, prijelaz Add: Luma Wipe,
otvara se dijaloski okvir Transition Name u kojem se moZe upisati
proizvoljno ime prijelaza ili ostaviti zadano. Nakon pritiska na OK
otvaraju se dodatne postavke prijelaza u kojima se mogu podesiti razne
opcije. Pritiskom na padajuci izbornik prve opcije Image moze se
odabrati jedan od mnogih vrsta efekata na tom prijelazu, kao $to je
prikazano na donjo;j slici.
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© Propertis for Lums Wipe' X

Svaki od tih efekata moze se isprobati tako da se odabere i nakon toga
pritisne na Preview Transition u istom dijaloSkom okviru. Slova A i B
oznacCavaju dvije razliite scene i kako ¢e se taj efekt ponasati izmedu
dviju scena. Nakon odabira efekta opcijom Softness moguce je
omeksati rubove tog efekta. Upisom ili odabirom strelice prema gore broj
postaje vedi, Sto znaci da ¢e rub efekta biti mekaniji. Upisom nize
vrijednosti ili pritiskom strelice prema dolje rub efekta postat ¢e ostriji.
Opcijom Invert izokrece se efekt obrnuto od pocetnog stanja. Nakon
podeSavanja opcija pritisne se OK. Za primjenu efekta potrebno je samo
u dijaloSkom okviru Scene Transitions u padaju¢em izborniku odabrati
prijelaz Luma Wipe te nakon toga pritisnuti na tipku Transition koja se
nalazi na sredini podrucja pregleda.

2.2.3. Virtualna kamera

Postavljena scena s ukljuéenom web-kamerom u OBS Studiju moze se
koristiti i u drugim aplikacijama koje koriste web kameru za razgovor ili

sastanak (Skype, Zoom, Teams, BigBlueButton i sl.). Za takvo koristenje
potrebno je odabrati dugme Start Virtual Camera u izborniku Controls.

Controls

Start Streaming

Start Recording

Start Virtual Camera
Studio Mode
Settings

Exit

Za dodatne opcije, potrebno je odabrati dugme sa strane Configure
Virtual Camera, nakon ¢ega se otvara dijaloski okvir Virtual Camera s
dodatnim opcijama.
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Zanimljivosti i napomene

OBS Studio prilikom izlaska
i ponovnog ulaska u
program pamti prethodno
postavljene scene i izvore
na tim scenama. Tako da je
za postavljanje potpuno
novih scena potrebno
obrisati postojecCe scene i

izvore te krenuti od pocetka.

& Virtual Camera *
Output Type
Internal

Qutput Selection

Program Output (Default)

OK Cancel

U podrucju Output Type moze se odabrati izmedu tri opcije:

Internal - Virtualna kamera ¢e pokazati ono $to OBS Studio obi¢no
ispisuje

Scene - Virtualna kamera prikazuje samo jednu scenu, bez obzira §to se
trenutno prikazuje u izlazima

Source - Virtualna kamera uvijek prikazuje jedan izvor
U podrucju Output Selection moguce je odabrati zeljenu scenu.

Otvaranjem neke trece aplikacije gdje se zeli koristiti virtualna kamera
odabere se samo pod izvor OBS-Virtual-Camera. Na donjoj slici moze
se vidjeti uklju€ivanje cijele scene pomocu virtualne kamere u program
Skype. Potrebno je bilo samo u opcijama programa umjesto kamere
koja se trenutno koristi, odabrati OBS-Virtual-Camera, oznaenu
crvenim okvirom na donjoj slici.

B Skype - [m] >

VIDEO

camera
O, Account & Profile
(=]
@ General ‘ ‘

2 privacy Prezentacija ‘

/. Appearance 'v -

Settings

0 Audio & Video J
Q, Calling Change background
o o | rev——
Messaging @ ol g ,
m . - . s
L) Notifications =y E
E Contacts )
Webcam settings

(i) Help & Feedback

Po istom principu moguce je ukljugiti virtualnu kameru OBS Studija u
bilo koji drugi program namijenjen za istu ili sliénu svrhu poput programa
Skype.
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2.3. Vjezba: KorisStenje programa

1.

Otvorite PowerPoint prezentaciju Suncev_sustav.pptx i
povecaijte ju (engl. maximize) preko cijelog zaslona.

U OBS Studiju obriSite sve scene (izbornik Scenes) ako
imate viSe od jedne tako da ostane samo jedna scena
koju nije ni moguce obrisati, a unutar te scene koja je
ostala obriSite sve izvore (izbornik Sources). Time se
krecCe s postavljanjem izvora i scena od samog pocetka
jer u protivnom program pamti prethodno postavljene
scene i izvore.

U OBS Studiju ukljucite Studio Mode i preimenujte scenu

koja je ostala u Prezentacija i kamera pa u tu scenu Lo ..
Zanimljivosti i napomene

dodaijte dva izvora. U prvi izvor tipa Window Capture
dodaijte prezentaciju Suncev_sustav.pptx. Nazovite Moguce je da se pod
izvor Prezentacija. U drugi izvor tipa Video Capture opcijom Add existing pojavi
Device dodajte svoju web-kameru ili, ako nemate prethodno postavijen izvor.
K dodaite virtualnu k . daiuc izb ik Dodajte potpuno novi izvor

ameru, dodajte virtualnu kameru iz padajuceg izbornika tako da ste sigurni koji ste
naziva OBS Virtual Camera. Nazovite izvor Web kamera izvor postavili.

i smanjite prikaz web-kamere ako vam prekriva cijeli

ekran.

Na izvor Prezentacija postavite filtar Crop/Pad. Do filtra
se dolazi pritiskom desne tipke miSa na izvor te odabirom
opcije Filters > + > Crop/Pad. Podesite filtar tako da se
vidi samo slajd preko cijelog zaslona.

Odaberite drugi slajd Sunce u prezentaciji te podesite
izvor Web kamera da se nalazi izmedu naziva Sunce i
zanimljivosti / opisa §to je to sunce. Svaki sljedeéi slajd
ima predviden prostor na toj poziciji ima predviden prostor
za prikaz web-kamere.

Dodajte novu scenu naziva Samo prezentacija i u nju
dodajte samo izvor tipa Window Capture te prilikom
dodavanja u dijaloSkom okviru Create/Select Source
odaberite opciju Add Existing. Nakon toga odaberite
izvor Prezentacija koji je stvorena u prosloj sceni. Ako je
potrebno, podesite veliinu prezentacije preko cijelog
zaslona.

Ostanite na sceni Samo prezentacija. Prije poCetka
snimanja provjerite mikrofon. Ako ne radi, dodajte ga kao
novi izvor (Audio Input Capture). Potrebno je proci kroz
sve slajdove u prezentaciji, ulaskom na novi slajd
potrebno je pri¢ekati cca 2 — 3 sekunde te procitati naziv
planeta / zvijezde i kratku zanimljivost. Nakon Citanja
teksta potrebno je opet priCekati cca 2 — 3 sekunde pa tek
nakon toga krenuti na sljedeci slajd koji se odabire u
prezentaciji.

Samo na prvom i posljednjem slajdu snimate video u
sceni Samo prezentacija, na svim ostalim slajdovima
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snima se iz scene Prezentacija i kamera. Prvo je
potrebno odabrati slajd pa tek onda prebacivanje na novu
scenu. 1z jedne scene u drugu prelazi se pomocu tipke
Transition u OBS Studiju.

8. Pokrenite snimanje prezentacije pritiskom na Start
Recording.

9. Nakon snimanja cijele prezentacije potrebno je pritisnuti
Stop Recording.

Zanimljivosti i napomene 10. Snimljeni videosadrzaj potrebno je pretvoriti u format

MP4. Pomocu opcije File > Remux Recordings odabere

Potrebno je upamtiti ili R Y
se upravo snimljeni videosadrzaj i pritisne na Remux.

zabiljeziti lokaciju
videosadrzaja jer ¢e se taj 11
videosadrzaj kasnije koristiti
u vjezbi.

. Preimenujte videosadrzaj tako da ima naziv
Suncev_sustav.mp4.
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3. Upoznavanje radnoga prostora e

programa Shotcut Trajanje
poglavlja:
Po zavrsetku ovoga poglavija moci cete: 45 min

e instalirati i pokrenuti program Shotcut

e prepoznati dijelove sucelja programa

o uvesti sliku ili video sadrzaj u program

e primijeniti mogucnost Playliste i Preglednika
e spremiti projekt.

3.1. Pokretanje i upoznavanje radnoga prostora
Shotcuta

Besplatan program Shotcut sluzi za obradu multimedijskih sadrzaja na
intuitivan nacin preko Timelinea (vremenske linije) kao i kod
profesionalnih alata za istu namjenu. U program Shotcut moguce je
uvesti slike, zvu€ne datoteke i video sadrzaje te njihovom kombinacijom
izraditi Zeljeni projekt.

3.1.1. Instalacija i pokretanje Shotcuta Zanimljivosti | napomene
Instalacijsku datoteku potrebno je preuzeti sa stranice Najpoznatiji sustavi za koje
https://www.shotcut.org/download. Odabere se poveznica, ovisno o vrsti je dostupan program
sustava, te se nakon toga preuzme instalacijska datoteka. Shoteut: Windows 10,
Windows 8, Windows 7,
Na dolje prikazanoj slici prikazane su poveznice preko kojih je moguce Windows Vista, Windows
preuzeti instalacijsku datoteku za operacijski sustav Windows, 64 bitne XP, Mac OS X 10.5-10.10,
. . v, v . . . . Ubuntu, Debian, Red Hat,
verzije sustava. Najlak3i nacin jest preuzimanje datoteke Windows OpenSUSE...
installer oznaCene crvenim okvirom na dolje prikazanoj slici, nebitno iz

kojeg izvora.

Windows 10 & 11
Site 1 (FossHub) Site 2 (GitHub)

Windows installer Windows installer

Windows portable zip | Windows portable zip

Nakon preuzimanja potrebno je pokrenuti datoteku i slijediti korake koji
se uglavnom sastoje od toga da se odabire dugme Next te na kraju
instalacije dugme Finish.

Shotcut je dostupan korisnicima operacijskih sustava Windows, Mac i
Linux 8to se moze i vidjeti pri preuzimanju instalacijske datoteke na gore
spomenutoj poveznici.

S obzirom na to da se radi o programu otvorenoga kbéda, osim verzije
programa koja je namijenjena obi¢nim korisnicima, mogucée je preuzeti i
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verziju programa (prikazano na donjoj slici) za korisnike koji su voljni
razvijati program i koji imaju odgovarajuc¢u vrstu znanja.

Other

Source code archive I’ GitHub repository

3.1.2. Pokretanje Shotcuta

Za pokretanje programa u sustavu Windows, odabere se dugme Start >
Sve aplikacije > Shotcut. Prilikom prvoga pokretanja program ¢ée se
sporije otvarati jer podeSava razne opcije, ali ¢e ve¢ drugi i svaki sljededi
put pokretanje biti puno brze.

Za pokretanje Shotcuta na Linux sustavima, klikne se na Applications >
Graphics > Shotcut.

Za pokretanje na sustavima Mac, potrebno je odabrati mapu
Applications te potom Shotcut.

3.1.3. Upoznavanje sa suceljem programa

Nakon pokretanja programa Shotcut, u srediSnjem dijelu programa
pojavljuje se izbornik New project, oznacen crvenim okvirom na donjoj
slici. Preko ovog brzog izbornika, moguce je odmah na pocetku odabrati
pod opcijom Project folder mapu gdje ¢e se spremiti buduci projekt i u
polje Project name upisati naziv projekta. U opciji Video mode moguce
je odabrati rezoluciju i broj kadrova (engl. frame rate) buduéeg projekta.
Nakon odabira, pritisne se na dugme Start. Ukoliko se ne Zeli odmah na
pocCetku stvoriti novi projekt, moguce je preskoditi izbornik tako da se na
karticu Playlist doda bilo koji multimedijski sadrzaj, nakon ¢ega Ce brzi
izbornik nestati i na tom mjestu ¢e se prikazati dodani multimedijski
sadrzaj.

Recent Projects

Korisni¢ko sucelje programa Shotcut podijeljeno je u Sest sekcija kao sto
je i prikazano na donjoj slici. Ako se program nije otvorio sa svih Sest
dolje prikazanih sekcija, potrebno ih je ukljuéiti klikom na dugmad
Playlist, History i Timeline koja se nalazi u Toolbaru. Sve sekcije mogu
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1. Menu Bar ili glavni izbornik — sadrzi glavne padajuée
podizbornike preko kojih je moguée doci do raznih funkcija i
dodatnih opcija u programu.

2. Toolbar — sadrzi preCace za naj¢eSce koristene naredbe i
blokove programa koje je moguce ukljuditi ili iskljuciti.

3. Source list — sastoji se od viSe kartica: Properties, Playlist,
Filters i Export. Na kartici Properties moguce je vidjeti glavne
informacije o ozna¢enom video sadrzaju poput trajanja, formata,
rezolucije, frame ratea i dr. Playlist obi¢no sadrzi jedan ili viSe
izvoriSnih video sadrzaja koji mogu biti prikazani na viSe nacina
(Details, Tiles, Icons). Na kartici Filters mogu se odabrati razni
filtri koji se mogu primijeniti na zvuk ili video sadrzaj. Zadnja
kartica Export sluzi za izvoz video sadrzaja u zeljeni format.

4. Viewer ili Preglednik — u njemu se pregledava izvorni video
sadrzaj ili sadrzaj vremenske linije (Timelinea). Preglednik
prikazuje trenutacno odabrani video sadrzaj, koji moze biti
odabran s popisa izvoriSnih video sadrzaja u kartici Playlist ili s
vremenske linije.

5. Layout — moguce je odabrati 6 razli€itih izgleda programa,
ovisno o tome Zeli li se vidjeti samo informacije o trenutnom
multimedijskom sadrzZaju, editirati multimedisjki sadrzaj, koristiti
efekti, podesavati boje, podesSavati audio ili samo pokrenuti
multimedijski sadrzaj preko cijelog programa.

6. Dialogs — dijalo3ki okviri Recent, History i Jobs, do kojih se
dolazi pomocu kartica na dnu dijaloskih okvira. Recent sluzi za
prikaz nedavno koristenih video sadrzajal/isjeCaka i slika. History
prati trenutne akcije u programu i biljezi ih tako da se moguce
vratiti na neke od prethodnih ako je potrebno. Jobs omogucuje
uvid prilikom izvoza video sadrzaja o tome koliko jo$ vremena
treba da se neki video sadrzaj izveze.
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7. Timeline ili vremenska linija — sluzi za obradu video isjeCaka u
konacan video sadrzaj. U Timeline se umecu video isjecci, slike,
zvuk, tekst te se obraduju do konaénog rezultata koji je spreman
za izvoz.

3.1.4. Prilagodba su€elja i postavki programa

Postavke programa moguce je prilagoditi preko izbornika Settings koji
se nalazi u glavnom izborniku kao $to je i prikazano na donjoj slici.

B untitled - Shoteut
File Edit View Player Settings Help

=~ 3
— h ects (unstable) [ u @
Open File  Open Other_ . N Aeter Properties Recent

Drag-n-drop to rearrange the
Language

Fusion Light

U izborniku Settings - Language moguce je odabrati Zeljeni jezik
programa. Za promjenu jezika programa potrebno je kliknuti na padajuéi
izbornik pokraj moguénosti Language te odabrati Zeljeni jezik. U ovoj
verziji programa nije dostupan hrvatski prijevod, ali mozda ¢e nekom
idu¢om verzijom programa i to biti jedna od opcija. Kako bi se promijenio
jezik treba zatvoriti program i ponovno ga pokrenuti kao $to je i
navedeno u skocnom okviru koji se pojavljuje prilikom promjene jezika.
Na gore prikazanoj slici ta je moguénost oznac¢ena crvenim okvirom.

NajceSc¢e se uz jezik mijenja i tema samoga programa. Do promjene
teme dolazi se preko izbornika Settings > Theme, gdje se moze
odabrati jedna od tri ponudene: System, Fusion Dark, Fusion Light.
Unaprijed zadana tema programa je Fusion Dark gdje je izraZen
dovoljno velik kontrast izmedu slova i blokova programa te je ta tema
najucestalija kod korisnika programa. Na gore prikazanoj slici ta je
mogucnost oznacena crvenim okvirom.

3.2. Uvoz multimedijskih datoteka

Ako se zeli uvesti slika, zvuk ili video isje€ak u program Shotcut,
potrebno je pratiti odredene korake kako bi se kasnije te datoteke mogle
koristiti u montazi.
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3.2.1. Uvoz slika, zvuka i video sadrzaja

Multimedijske datoteke (kao Sto su slika, zvuk ili video) uvoze se u
program Shotcut metodom Povuci i ispusti (engl. Drag and drop) na
dva nacina ili preko izbornika.

Prvi nacin jest odabrati zeljenu multimedijsku datoteku na raunalu,
uhvatiti ju lijevom tipkom miSa i prenijeti na bilo koje podrucje unutar
programa (osim u Timeline ili Playlist). Datoteka ¢e se prikazati u
Pregledniku i ako se radi o video isjecCku ili zvuénoj datoteci automatski
Ce se pokrenuti, dok Ce se slika prikazati. Ako smo zadovoljni sadrzajem
datoteke mozemo je dodati u Playlist za kasnije koriStenje. Datoteka Ce

se dodati tako da se pritisne na dugme n , Add the Source to the
playlist, na donjem dijelu kartice Playlist.

+ = [ v B = i

. Add the Source to the playlist (Shift+4)
Playlist -

Drugi nacin jest odabranu multimedijsku datoteku uhvatiti ljevom tipkom
misa i prenijeti u podrucje kartice Playlist u programu. Datoteka ¢e se
takoder prikazati u Pregledniku, ali ¢e se ujedno i umetnuti u karticu
Playlist te time postaje spremna za dodavanje i koristenje u Timelineu.

Datoteke se mogu umetnuti i preko izbornika File te odabirom naredbe
Open File, nakon &ega se otvara dijaloski okvir Open File u kojem se
odabere datoteka na racunalu i otvori dvostrukim klikom lijeve tipke miSa
ili klikom na dugme Open. Naredbi Open File moze se i pristupiti preko
dugmeta Open File koja se nalazi na Toolbaru ili pritiskom na dugme

iles to playlist, na donjem dijelu kartice Playlist. Nakon
Add files to playlist donjem dijelu kartice Playlist. Nak
otvaranja, datoteka ¢e se prikazati u Playlisti.

3.3. Priprema za izradu projekta

3.3.1. Playlista i Preglednik

Na dolje prikazanoj slici moze se vidjeti kako izgledaju tri proizvoljno
odabrane datoteke umetnute izravno u Playlist. Na kartici Playlist
datoteke su poredane po brojevima, a rangirane su ovisno o trenutku
umetanja u Playlist (stupac ,#*), tako da je pod rednim brojem ,1“ ona
koja je prva umetnuta, ,2° druga, itd. Datoteke koje se ve¢ nalaze u
kartici Playlist mogu i mijenjati redoslijed tako da se uhvati jedna od njih,
drzi se lijeva tipka misa i ubaci ispred ili iza zeljene datoteke. Na taj se
nacin datoteke mogu razvrstati u skladu s vlastitim potrebama i Zeljama.
U stupcu Clip prikazuje se puno ime i format umetnute datoteke, a u
stupcu Duration prikazuje se trajanje video ili audio datoteke.

@ srce .



Osnove rada s alatima za snimanje i obradu videosadrzaja (M200)

Playlist

= Thumbnails Clip In Duraticn Start Date

g Zalazak_s -
ke i 00:00:00:00 00:00:20:04 00:00:00:00 2017-03-15 11:09:24
$

plaza.mp4

- d ‘f‘l ek
5 po rt.m [:l-l

= mb
: f Kava_na_stolu.mpd

Preglednik sluzi prvenstveno za pregled multimedijskoga sadrzaja, ali
osim toga, nudi i neke druge korisne funkcije koje ¢e biti opisane u
nastavku.

Za pregled video ili audio sadrZaja koriste se kontrolne tipke prikazane
na donjoj slici:

1. Presko¢i na prethodnu tocku ili pocetak reprodukcije
(engl. Skip to the previous point).

2. Pokreni video brzo unatrag (engl. Play quickly
backwards).

3. Zapocni ili pauziraj reprodukciju (engl. Start playback).

4. Pokreni video brzo naprijed (engl. Play quickly
forwards).

5. Preskodéi na sljedecu tocku ili kraj reprodukcije (engl.
Skip to the next point).

6. Podesi zumiranje (engl. Toggle zoom). Klikom na
pripadajucu strelicu otvara se dodatni izbornik za odabir
nekoliko unaprijed zadanih opcija.

7. Ukljuéivanje prikaza mreze (engl. Toggle grid display on
the player). Klikom na pripadajuéu strelicu otvara se

dodani izbornik gdje se mogu odabrati razne opcije
prikaza linija po Pregledniku.

8. Prikaz kontrola zvuka (engl. Show the volume control).

U donjem lijevom kutu Preglednika nalazi se informacija o trenutanom
vremenu i o ukupnom trajanju pokrenutoga multimedijskog sadrzaja.
Kao $to se moze vidjeti na donjoj slici, ukupno trajanje iznosi 20,07
sekundi, a trenutacno se reprodukcija nalazi na vremenu od 2,19
sekundi. Pokraj trenutacne pozicije prikaza vremena nalazi se okretno
dugme pomocu kojega se moze pomicati video sliCicu po sli€icu (frame
by frame) naprijed ili natrag. To je korisno ako se zeli zaustaviti
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multimedijski sadrzaj na tocno odredenom kadru radi daljnje obrade
(rezanje, umetanje novoga sadrzaja na tom mjestu, premjestanje itd.).

> /[ 00:00:20;07

00:00:02;19 &

Osim $to se trenutaéna pozicija reprodukcije vidi preko prikaza vremena,
moze se vidjeti i na kontrolnoj plogi kao $to je prikazano na donjoj slici.

" I:I 0 , N 000 I:II :0 Em:l , |I:I 0:0 I:II :0 -'|-_;I3I:I

Sivi trokuti¢ s produZzenom linijom do oznake vremena, naziva se joS i
pokaziva€ u traci, a oznacava trenutacno mjesto reprodukcije
multimedijskoga sadrzZaja i on je uvijek prikazan na kontrolnoj plogi.
Osim njega postoje pocetni i zavrsni markeri koji se mogu pomicati,
ovisno o potrebi. Lijevi trokuti¢ se joS naziva i po€etni marker, a
oznaCava mjesto od kojeg ¢e krenuti multimedijski sadrzaj, tj. startnu
poziciju. Desni trokuti¢ naziva se zavr$ni marker i ozna¢ava mjesto ili
frame do kojeg ¢e se reproducirati multimedijski sadrzaj. Multimedijski
sadrzaj ¢e se reproducirati samo unutar poCetnog i zavrSnog markera
Cije podrugje ima plavu ispunu i crveni okvir kao $to je i prikazano na
gornjoj slici.

Kada se postave pocetni i zavr$ni marker unutar multimedijskoga
sadrzaja, u donjem desnom kutu Preglednika pojavi se vrijeme
pocetnog markera (/n Point) i ukupno vrijeme selektiranoga
multimedijskog sadrzaja (Selected Duration), {j. vrijeme od poéetnog
markera do zavr$nog markera kao $to je i prikazano crvenim okvirom
na donjoj slici. Poetak multimedijskoga sadrzaja u donjem sluéaju
pocinje od 8,27 sekunde, a ukupno trajanje je 9,24 sekunde iako se
moze vidjeti ispod zavrSnog markera da izvorni multimedijski sadrzaj
traje viSe od 17 sekundi.

||:| 0:00:14,00

Jos su dvije vazne opcije u Pregledniku, Source i Project, a odabrati se
mogu u donjem lijevom kutu Preglednika.

45
[00:00:49;29 |

Source Project

Svaki multimedijski sadrzaj koji se umetne u Playlist ili izravno u
Preglednik pokrenut ¢e se u Source opciji. Ako se u karticu Playlist
odjednom umetne viSe multimedijskih datoteka, pokrenut ¢e se samo
ona koja je prva po redoslijedu.
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Opcija Project sluzi za prikaz trenutacnoga projekta na kojem se radi.
Obi¢no se ova opcija veze za Timeline o kojem ¢e biti rije€i u drugom
poglavlju, a ako nema nista u podrucju Timelinea prikazat e se svi
multimedijski sadrzaji koji se nalaze u kartici Playlist poredani po
brojevima, kao &to je to prikazano na gornjoj slici. MozZe se prebacivati
od broja do broja, tj. datoteke do datoteke pomoc¢u dugmadi Preskogi
na prethodnu tocku ili pocetak reprodukcije ili Presko¢€i na sljede¢u
tocku ili kraj reprodukcije.

Playlist =~ Filters = Properties

Na dnu kartice Playlist nalazi se jo$ nekoliko dugmadi, a neka od njih je
vezana i za opciju Source:

1. Prikaz izbornika s dodatnim moguénostima (engl.
Playlist menu).

2. Dodaj Source sadrzaj u Playlist (engl. Add the Source
to the playlist).

3. Ukloni oznaceni sadrzaj s kartice Playlist (engl.
Remove cut).

4. Dodaj sadrzaj u Playlstu (engl. Add files to Playlist).
5. Azuriraj Source sadrzaj (engl. Update).

6. Prikaz kartice Playlist u obliku detalja (engl. View as
details).

7. Prikaz kartice Playlist u obliku plocica (engl. View as
tiles).

8. Prikaz kartice Playlist u obliku ikona (engl. View as
icons).

Kada je multimedijski sadrzaj otvoren samo u opciji Source, u Playlist se
dodaje pomocéu dugmeta Dodaj Source sadrzaj u kartice Playlist. Ako
se u meduvremenu taj sadrzaj promijeni pomoc¢u poc€etnog i zavrSnog
markera, tada se i taj promijenjeni sadrzaj moze dodati u Playlist kao
novi multimedijski isje€ak. Takoder, pomo¢u dugmeta Azuriraj Source
sadrzaj moze se samo azurirati multimedijski sadrzaj koji se od ranije
nalazi u kartici Playlist.

3.3.2. Spremanje projekta

U programu Shotcut svaki se projekt sprema na intuitivan i jednostavan
nacin kao i u vecini drugih programa koji nisu namijenjeni obradi
multimedijskih sadrZaja. Kada se Zeli spremiti projekt, potrebno je
odabrati izbornik File i naredbu Save As. Nakon odabira naredbe otvara
se dijaloski okvir Save XML u kojem se odabire mjesto spremanja
projekta na raCunalu i naziv datoteke. Projekt je moguce spremiti samo u
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jedan format, MLT XMLS (*.mlt), koji je ujedno i izvorni format Shotcuta.
Spremljena datoteka moZe se izvesti u vec¢inu najpoznatijin formata o
¢emu Ee biti rije€i u zadnjem poglavlju. Nakon odabira mjesta spremanja
i naziva datoteke potrebno je samo kliknuti na dugme Spremi.

Do naredbe Save moze se dodi i preko Toolbara, klikom na dugme
Save.
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3.4. Vjezba: Upoznavanje radnoga prostora

1. Umetnite tri video sadrzaja u program Shotcut u Playlist:
Kava.mp4, Razni_poslovi.mp4, i Rijeka.mp4.

2. U video sadrzaju Razni_poslovi.mp4 izdvojite drugi
(8ivanje) i treci (sviranje) posao. Stvorite nova dva video
isjeCka iz njih pomoc¢u poc€etnog i zavrSnog markera i
naredbe Dodaj Source sadrzaj u Playlist.

3. Video sadrzaju Rijeka.mp4 podesite ukupno trajanje od
10 sekundi po vlastitom izboru. Nakon toga provjerite
vrijeme trajanja video sadrzaja, ako se nije promijenilo
azurirajte sadrzaj naredbom Azuriraj Source sadrza;j.

4. |z Playliste izbriSite video sadrzaje Razni_poslovi.mp4
(sviranje) i Kava.mp4 pomoc¢u naredbe Ukloni oznaéeni
sadrzaj s kartice Playlist.

5. U Projektu se postavite na pocetak prethodno
izdvojenoga video isjeCka Sivanje pomocu naredbi
Preskoci na sljedecu tocku ili kraj reprodukcije ili
Preskodi na prethodnu tocku ili pocetak reprodukcije
ovisno o tome gdje se nalazite u Projektu.

6. Spremite projekt pod nazivom Projekt_1.mit.
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4. Montaza multimedijskih sadrzaja -

Trajanje
Po zavrsetku ovoga poglavija moci cete: poglavlja:
e dodavati multimedijske sadrzaje u Timeline (vremensku liniju) 70 min

e primijeniti mogucnosti video i audio trake
e primijeniti naredbe Timelinea (vremenske linije)

e primijeniti mogucnost postupnoga pojacavanja i smanjivanja
intenziteta zvuka.

Program Shotcut nudi razne vizualne i audio efekte nad nekim
multimedijskim sadrzajem, ali prije njihovoga koridtenja potrebno se
upoznati s Timelineom. Montaza je tehniCki postupak u kojem se slazu
po redoslijedu odabrani multimedijski elementi da bi se dobio kona¢an
multimedijski sadrzaj koji moze biti sastavljen od slike, zvuka, teksta i
videa.

4.1. Timeline (Vremenska linija)

Timeline se nalazi na dnu programa, kao $to je i prikazano na donjoj
slici, i sluzi za montazu video projekata na linearan nacin. Multimedijski
sadrzaji slazu se vodoravno, jedan iza drugoga, a ako Timeline sadrzi
viSe video traka i na svakoj od njih je u istom trenutku neki multimedijski
sadrzaj, prikazuje se onaj sadrzaj koji je na najvisoj video traci.

v <> Neoe@®® S

||ilu 00:10

Ako Timeline u programu nije prikazan, moze ga se ukljuciti klikom na
E

Timeline

dugme Timeline u Toolbaru.

Multimedijski sadrzaji mogu se umetnuti u Timeline metodom Povuci i
ispusti (engl. Drag and Drop) iz kartice Playlist ili iz Source dijela
programa. Ako se umecu iz kartice Playlist, potrebno je oznaditi
datoteku, pritisnuti i drzati lijevu tipku miSa, do¢i miSem do podrucja
Timelinea i ispustiti datoteku, tj. pustiti lijevu tipku misa. Isti se postupak
moze primijeniti ako se multimedijski sadrzaj umece iz Source podrucja.
U istu video traku moze se umetnuti proizvoljan broj multimedijskih
sadrzaja na neki od gore opisanih nacina. Multimedijski se sadrzaj moze
i micati po video traci tako da se pritisne lijevom tipkom mi$a na Zeljeni
sadrzZaj i pomice ga se na Zeljeno mjesto u istoj traci ili u drugu traku.

Bijeli trokuti¢ na koji se nastavlja okomita linija oznaava mjesto, {j.
vrijeme multimedijskoga sadrzaja u Timelineu. Na sljedecoj slici linija se
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nalazi malo prije 5. sekunde video isje¢ka ,Rijeka_u_pokretu.mp4*.
Osim $to pokaziva€ omogucuje postavljanje na odredeno mjesto u video
ili audio traci te pregledavanje projekta, sluzi i kao pokazatelj na kojem
mjestu ¢e se nesto odraditi s multimedijskim sadrzajem. Na primjer, ako
se zeli odrezati neki video isje€ak, treba postaviti pokaziva€ na mjesto
koje treba biti odrezano te odabrati odgovaraju¢u naredbu. Takoder, ako
se zeli zalijepiti multimedijski sadrzaj na neko odredeno mjesto u traci,
postavi se pokaziva¢ na to mjesto i nakon toga odabere naredba za
lijepljenje, itd.

Nakon Sto se multimedijski sadrzaj prebaci u Timeline, automatski ¢e se
stvoriti nova traka naziva V1 u kojoj se nalazi umetnuti multimedijski
sadrzaj (prikazano crvenim okvirom na donjoj slici).

Naziv trake moze se u bilo kojem trenutku promijeniti tako da se lijevom
tipkom misa pritisne na trenutacni naziv trake i upiSe novi, Zeljeni naziv

trake. Nakon upisa potrebno je pritisnuti tipku [Enter] za potvrdu novog

imena. Ispod naziva trake (V1) nalaze se jos tri dugmeta:

e prvo dugme H sluzi za zaklju€avanje trake. Traka se
zaklju€ava ako se ne Zeli utjecati na multimedijske sadrzaje u
njoj na bilo koji nacgin (rezanje, premjestanje, rotiranje itd.).

l' ]
e drugo dugme sluzi za potpuno stiS8avanje zvuka ili ponovno
uklju€ivanje zvuka

e posljednjim dugmetom E moze se prikazati ili sakriti
reprodukcija video trake.

Ispod naziva Timeline nalazi se dugme E Timeline menu koje sluZi
za prikaz dodatnih opcija samoga Timelinea.

U skupini Track Operations mogu se dodati audio ili video trake
pomocu naredbi Add Audio Track ili Add Video Track, a moze se i
obrisati oznacena traka pomo¢u naredbe Remove Track.

U skupini Options, uklju€ivanjem opcije Ripple All Track, sve se video i
audio trake ponasaju sinkronizirano. Na primjer, ako se dva video
isjeCka nalaze u jednoj traci, a izmedu njih je prazan prostor, prilikom
brisanja toga praznog prostora, prvi i drugi video isjeCak se spajaju, ;.
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nizu se jedan iza drugog bez obzira na ostale video trake. Kada se
uklju€i mogucnost Ripple All Track i nakon nje se obriSe prazan prostor
izmedu dva video isjeCka u jednoj traci, pomaknut ¢e se svi multimedijski
sadrZaji u svim trakama za duljinu izbrisane praznine.

U istoj skupini, naredba Show Audio Waveforms sluzi za prikaz valnih
oblika audio trake, a naredba Show Video Thumbnails sluzi za prikaz
video sliica na multimedijskom sadrzaju. U skupini Other, naredba
Reload koristi se ako je potrebno ponovno ucitati multimedijske
sadrzaje.

Trake u Timelineu mogu biti vide ili niZze, a njihova dimenzija moze se
podeSavati naredbama Make Tracks Shorter za odabir niZe visine trake
ili naredbom Make Tracks Taller za odabir viSe visine trake koje se
nalaze u skupini Track Height.

Pokraj dodatnih mogucénosti u Timelineu nalaze se tri standardna

dugmeta BN |2re%i, Kopiraj i Zalijepi. Prije Koritena tipki

Izrezi i Kopiraj potrebno je oznaciti Zeljeni multimedijski sadrzaj u traci.
Kod tipke Zalijepi potrebno je prije koriStenja oznaciti traku u koju se Zeli
zalijepiti multimedijski sadrzaj i pokazivaCem miSa odabrati mjesto gdje
se Zeli zalijepiti multimedijski sadrzaj unutar te trake.

4.2. Osnovne naredbe Timelinea
Osim metodom povuci i ispusti, multimedijski sadrzaj moze se

prebaciti u Timeline i pomo¢u dugmeta n Append. Potrebno je prvo
oznaciti zeljenu traku u Playlisti i nakon toga pritisnuti na dugme.
Multimedijski sadrzaj koji se nalazi u Source dijelu dodat ¢e se na kraj
oznacCene trake.

Dugme = Ripple Delete sluzi za brisanje bilo kojega multimedijskog
sadrzaja u traci. Oznaceni multimedijski sadrzaj se obriSe, a sav
preostali sadrzaj u toj traci se pomakne ulijevo za duljinu trajanja
obrisanoga multimedijskog sadrzaja, $to znaci da nece ostati nikakva
praznina u traci nakon brisanja ovim dugmetom.

Ako se zeli u traci obrisati neki multimedijski sadrzaj, a da se ne utjeCe

~
na poziciju ostalih sadrzaja, koristi se dugme Lift kojim se samo
~podigne” oznaceni multimedijski sadrzaj u traci i nakon toga ostane
prazno mjesto duljine uklonjenoga multimedijskog sadrzaja.

Oznaceni multimedijski sadrzaj moze se i prebrisati sa sadrzajem u

Sourceu ili kopiranim sadrzajem iz Timelinea pomocu dugmeta
Overwrite clip onto the current track. Potrebno se pokazivatem
postaviti na bilo koji dio trake gdje e biti poCetak novoubadenoga
multimedijskog sadrZaja te odabrati ovu naredbu. Bitno je napomenuti
da ¢e od mjesta na kojem se postavi pokazivaC u traci pa nadalje svi
postojeéi multimedijski sadrzaiji biti prebrisani novim u duljini trajanja
novododanoga sadrzZaja.
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Multimedijski sadrzaj moze se odrezati i u Timelineu. Potrebno se
postaviti na mjesto u video traci gdje se Zeli odrezati neki multimedijski

sadrzaj i nakon toga odabrati dugme Split at Playhead.
Multimedijski sadrzaj ¢e se na to€no odabranom mjestu prerezati na dva
dijela. Na dolje prikazanoj slici moze se vidjeti postavljanje pokazivaca
na zeljeno mjesto rezanja u video isje¢ku ,Slap.mp4“.

Timeline
S %Gl +=AVvII v Ne@®® S

Output 00:00:00 |00:00:05 | 00:00:10

Video sadrzaj

g v e

Nakon pritiska dugmeta Split at Playhead video isje¢ak ,Slap.mp4*
razdvaja se u dva zasebna video isjeCka kao $to je prikazano na donjoj
slici.

Timeline
Ne@®® S

Output

Video sadrzaj

g v o

Dugme n Create/Edit Marker sluzi za postavljanje markera/oznake u
vremenskoj liniji. Markeri sluze za ozna€avanje dijela vremenske linije
gdje je nesto potrebno odraditi ili samo kao podsjetnik za neki dio video
isjeCka. Ako postoje vise markera, premjestati se moze po njima

pomocu dugmadi < 0 Next i Previous Marker.

Pomoc¢u dugmeta m Toggle snapping moguce je ukljuciti ili iskljuciti
LJijeplienje“ multimedijskih sadrzaja u nekoj traci. Kada je naredba
ukljuena, dovoljno je odvuci proizvoljan multimedijski sadrzaj u blizinu
drugoga multimedijskog sadrzZaja u istoj traci i oni ¢e se prilijepiti jedan
uz drugoga.

Kada se Zeli umetnuti neki multimedijski sadrzaj izmedu dva postojeca u
nekoj traci, javlja se problem da novi multimedijski sadrZaj prebriSe

postojedi. Ispravan nacin za umetanje jest pritiskom na dugme
Ripple trim and drop koje omogucuje umetanje novih multimedijskih
sadrzaja bez utjecaja na duljinu postojecih.

Osim Sto se trake u Timelineu mogu smanijiti ili povisiti, i sdm prikaz
sadrzaja moze se uvecati ili smanijiti pomo¢éu dugmadi Zoom timeline

out (povecalo s minusom) i Zoom timeline in (povecalo s plusom)

S &y Ova mogucnost korisna je u gotovo svim

situacijama. Kada se u Timelineu nalazi vise multimedijskih sadrzaja,
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samo se smanji prikaz sadrzaja pomo¢u dugmeta Zoom timeline out,
do mjere kada su vidljivi svi multimedijski sadrzaji nakon ¢ega se vidi
kompletna slika trenutacnoga projekta. A ako se zeli precizno vidjeti na
kojoj se slicici (engl. frame) nalazi pokazivac, ili se zeli precizno odrezati
neki multimedijski sadrzaj, potrebno je zumirati Timeline pomoc¢u
dugmeta Zoom timeline in. Osim pomo¢u dugmadi, moguce je mijenjati
zumiranje i pomocu horizontalnoga klizaca koji se nalazi izmedu dva
povecala. Pritisne se i drZi lijeva tipka miSa i povlaéi u Zeljenom smjeru.
Kada se zavrsi s izmjenom zumiranja, pusti se lijeva tipka misa.

Na donjoj slici moze se vidjeti smanjena traka ,Video sadrzaj“ u kojoj su
multimedijski sadrzaji duzi od 3 minute. Traka je smanjena te su
ispisana samo okvirna vremena.

Kada se maksimalno poveca prikaz sadrZaja u Timelineu, kao §to je
prikazano na donjoj slici, moze se vidjeti puno precizniji prikaz
multimedijskoga sadrzaja i precizno vrijeme na koje se postavi
pokazivac.

¥R = vII 9 <> e
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Video sadrzaj moze se skratiti ili produZziti do svojeg maksimalnog
trajanja i pritiskom na prvu ili zadnju liniju video isjeCka dodanog u
Timeline. Potrebno je do¢i pokazivaCem miSa na pocCetak video isjeCka
(pojavit ¢e se zelena linija na pocetku) ili na kraj video isjeCka (pojavit ¢e
se crvena linija), pritisnuti i drzati lijevu tipku miSa te se pomicati u
Zeljenom smjeru. Ako se Zeli skratiti trajanje video isjeCka na pocetku,
potrebno je doc¢i na pocCetak video sadrZaja te se pri pojavljivanju zelene
linije pritisne i povladi taj prvi rub video sadrZaja u desnu stranu. Pojavit
¢e se i duljina trajanja, tj. skracivanja video sadrzaja kao $to je prikazano
na donjoj slici. Kada se dode do Zeljenog vremena ili pozicije, samo se
pusti lijeva tipka misa.

@®®®® S
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4.3. Rad sazvukom

Svaki video dobiva dodatno na kvaliteti kada mu se doda zvuk ili ga se
poprati zvuénim efektima. Zbog toga je potrebno znati na pravilan nacin
umetati zvu¢ne datoteke u Timeline.

Zvuk se moze dodati u Playlist istom metodom kao i slika te video
sadrzaj, a razlika postoji samo prilikom prebacivanja u Timeline. Prije
dodavanja u Timeline potrebno je izraditi audio traku. Prvi nacin jest
pritiskom na desnu tipku miSa unutar Timelinea i odabirom naredbe Add
Audio Track. Drugi nacin jest pritiskom na dugme Display a menu of
additional actions i odabirom naredbe Add Audio Track. Nakon toga
stvara se nova audio traka u koju se moze umetnuti audio sadrzaj u
svim najpoznatijim formatima.

Timeline

= Ne@®®

Output 00:00:00 5
A

Kao $to je i na gornjoj slici prikazano, audio traka je niZza od video trake i
ima samo dva dugmeta ispod naziva trake ,A1“. ZadrZzano je samo
dugme za potpuno stiSavanje zvuka i dugme za zaklju¢avanije trake, a
ostala dugmad nije potrebna jer se odnosi na video sadrzaj i slike. Na
zvuénoj traci moze se primijeniti sva dugmad na Timelineu, opisana
ranije kada je bilo rijeci o video traci.

Cesto se koristi dugme Split At Playhead za rezanje audio sadrzaja jer
je on obi¢no dulji od video isje€aka ili slika. Na donjoj slici moze se
vidjeti situacija gdje je audio sadrzaj dulji od video sadrzaja.

Y gl = A vIII ® <> MNe@®® S
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Za rezanje audio sadrzaja, potrebno ga je oznaditi i postaviti se na
mjesto gdje se Zeli odrezati, a obi¢no je to kraj video isje€aka ili slika,
kao $to je prikazano na gornjoj slici. Nakon toga se pritisne dugme Split
At Playhead. Odrezani audio sadrZaj moze se oznaditi i obrisati nakon
Cega ¢e audio sadrzaj biti poravnat s video sadrzajem kao &to je i
prikazano na donjoj slici.

¥E @l +=AvI v <> Ne@®® S

Dexter_Britain_- 06, -_Summers_Comi

W T T

Kada su tako poravnati video i audio, istovremeno se reproducira
sadrzaj u video i audio traci te se na taj nain montira projekt u neku
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zavrsnu, smislenu cjelinu. Ako video sadrzaj u sebi sadrzi neki audio,
prilikom reprodukcije preklapat ¢e se oba audio sadrzaja, onaj iz audio
trake i video trake. Za reprodukciju zvuka samo iz audio trake potrebno
je na video traci pritisnuti na dugme Mute tako da se reproducira zvuk
samo iz audio trake.

Prikaz audio sadrzaja nacinjen je od valovitih amplituda koje oznaCavaju
razli€itu razinu glasnoce. Taj dio moze se sakriti ili prikazati,
uklju€ivanjem ili isklju¢ivanjem naredbe Show audio waveforms do
koje se dolazi preko izbornika Display a menu of additional actions u
skupini Options.

Ako audio sadrzaj od poCetka ima isti, glasan intenzitet zvuka, moguce
je na jednostavan nacin podesiti kretanje od tiSeg prema glasnijem
zvuku.

Potrebno je oznaditi audio sadrzaj na kojem se Zeli omoguciti postupno
pojaCavanje zvuka te se postaviti miSem u lijevi gornji kut audio trake.
Pojavit e se treptajuci kruzi¢ kao $to je prikazano crvenim okvirom na
gornjoj slici. Lijevom tipkom miSa pritisne se i drZi kruzi¢ te se povlaci u
desnu stranu audio trake do Zeljenog vremena, koje se moze vidjeti na
vrhu Timelinea. Tako je primjerice mogucée da od najtiSeg do
najglasnijeg intenziteta zvuka produ dvije sekunde ili 20 sekundi, ovisno
0 mjestu do kojeg ¢e se povladiti to¢ka. Nakon odabira Zeljenoga
vremena, pusti se lijeva tipka misa.

Na gornjoj slici moze se vidjeti izgled audio trake u kojoj je postupno
pojacan intenzitet zvuka. Grafi¢ki je to prikazano sjenom koja je na
pocetku najdeblja, a prema kraju je sve tanja $to opisuje da se na
pocetku uopce ne Cuje zvuk, a prema kraju je sve glasniji, do tocke gdje
se spaja s intenzitetom originalnoga zvuka.

Na donjoj slici moZe se vidjeti izgled audio trake u kojoj je postupno
smanjen intenzitet zvuka. Obi¢no se to radi na kraju audio trake tako da
se zvuk ne smaniji naglo vec se postepeno smanjuje zadnjih nekoliko
sekundi. Graficki je to prikazano sjenom koja je na pocetku najtanja, a
prema kraju je sve deblja, Sto opisuje da se zvuk na pocetku Cuje
normalno, a prema kraju je sve tisi.
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4.4. Vjezba: Montaza video sadrzaja

1.

Umetnite Sest multimedijskih sadrZaja u Playlist programa
Shotcut. Sastanak.mp4, Slap.mp4,
Sport_skejtbord.mp4, Dexter_Britain_-_10_-
_Train.mp3, Jezero.png i More.png.

Ubacite u Timeline video sadrZaje Sastanak.mp4,
Slap.mp4 i Sport_skejtbord.mp4 tocno tim
redoslijedom. Pomaknite video sadrzaje jedan do
drugoga i promijenite naziv video trake iz ,V1“ u ,Video
sadrzaji“.

Dodajte u Timeline novu video traku pomocu naredbe
Add Video Track i promijenite joj naziv u ,Slike®“. Ubacite
u nju slike Jezero.png i More.png. Slike se trebaju poceti
prikazivati od pocetka i trebaju biti postavljene jedna do
druge.

Smanijite visinu prikaza traka pomocu naredbe Make
Tracks Shorter.

Dodaijte audio traku i promijenite joj naziv u ,Pozadinska
glazba“. Ubacite zvu¢nu datoteku Dexter_Britain_-_10_-
_Train.mp3 u audio traku i poravnajte ju da po¢ne od
pocetka.

Oznadite video sadrzaj Slap.mp4 i podignite ga pomocu
dugmeta ,Lift“ tako da ostane prazno mjesto duljine
uklonjenoga videa.

Premjestite slike Jezero.png i More.png u traci Slike do
praznog mjesta prethodno uklonjenoga video sadrzaja
tako da se prikazuju te dvije slike izmedu video sadrZaja
Sastanak.mp4 i Sport_skejtbord.mp4. Pomaknite video
sadrzaj Sport_skejtbord.mp4 do zavrSetka prikaza
zadnje slike u traci Slike tako da video izgleda
neprekinuto prilikom reprodukcije.

Odrezite zvuénu datoteku Dexter_Britain_-_10_-
_Train.mp3 pomocu naredbe Split At Playhead tako da
ima isto trajanje kao i posljednji video sadrzaj
Sport_skejtbord.mp4. ObriSite odrezani dio tako da
ostane samo onaj ispod multimedijskih sadrzaja.

Spremite projekt pod nazivom Projekt_2.mlit i pregledajte
cijeli sadrzaj.

Ako ste zavrsili prethodne zadatke prije predvidenog vremena, pokusajte
rijesSiti i sliedeci zadatak:

1. Postupno pojacajte zvuk na pocetku zvuéne datoteke
Dexter_Britain_-_10_-_Train.mp3 i postupno smanijite zvuk na
kraju iste zvu€ne datoteke u trajanju od tri sekunde.
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5. Animacije i vizualni efekti -

Trajanje
Po zavrsetku ovoga poglavilja moci cete: poglavlja:
e postaviti Zeljenu vrstu i trajanje prijelaza izmedu 50 min

multimedijskih sadrzaja

e primijeniti mogucnost postupnoga prikazivanja ili nestajanja
video sadrZaja

e promijeniti brzinu reprodukcije video sadrZaja

e primijeniti mogucnosti audio i video filtara

e postaviti keyframeove u efektima na video sadrZaju .

Shotcut pruza moguénost dodavanja prijelaza izmedu dva multimedijska
sadrzaja, a ti se prijelazi nazivaju jo$ i animacije. Animacije olakSavaju
gledanje nekoga video sadrzaja jer pruzaju mogucénost blagoga prijelaza
iz jedne scene u drugu. Animacije se mogu postaviti na videozapise i
fotografije.

5.1. Postavljanje prijelaza izmedu multimedijskih
sadrzaja

U programu Shotcut moze se na jednostavan nacin postaviti prijelaz
izmedu dva multimedijska sadrzaja u video traci.

Za postavljanje prijelaza potrebno je imati dva multimedijska sadrzaja u
istoj traci poredana jedan do drugoga kao $to su na donjoj slici video
sadrzaji ,Slap.mp4* i ,Kava.mp4*.

<> Ned®® S

| 0:00:30

Nakon toga, prijelaz je moguée postaviti na dva nacina. Prvi je nacin,
prema gornjem primjeru, da se video sadrzaj Kava.mp4 uhvati lijevom
tipkom misa i odvuce prema video sadrzaju Slap.mp4. Prilikom
povlagenja pojavit ¢e se vrijeme koje oznacava koliko ¢e sekundi trajati
prijelaz iz jednog video sadrzaja u drugi. Oznaka vremena pojavljuje se
na mjestu gdje se pokazivatem misa kliknulo na video sadrzZaj, na donjoj
slici to je -02:05 sekunde.
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Drugi je nacin da se uhvati video sadrzaj Slap.mp4 i odvuce prema
video sadrzaju Kava.mp4. Konacan rezultat je isti, samo je razlika hoce
li se video sadrzaj pomicati prema pocetku video trake ili prema kraju.
Nakon $to se pomicanjem dode do Zeljenog vremena prijelaza izmedu
dva video sadrzaja pusti se lijeva tipka misa. Prikazat ¢e se oznaka za
prijelaz izmedu multimedijskih sadrzaja, dva ljubi¢asta trokuta okrenuta
jedan prema drugome kao $to se vidi na donjoj slici.

> Ne@®@® S
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Trajanje prijelaza mozZe se i naknadno korigirati. Potrebno je kliknuti i
drzati lijevu tipku miSa na rubu prijelaza na kojem se pojavljuje zelena
linija i odvuci prijelaz do Zeljenog trajanja, veceg ili manjeg. Prilikom
pomicanja pojavljuju se dva prikaza vremena iznad pokazivaca misa,
kao Sto se vidi na donjoj slici.

Lijeva strana prijelaza ima predznak ,+“ i moze se pomicati samo u
desnu stranu gdje se smanjuje trajanje prijelaza, ali se poveéava prikaz
video sadrzaja. Desna strana prijelaza ima predznak ,-“ i moze se
pomicati samo u lijevu stranu gdje se takoder smanjuje trajanje prijelaza
i povecava prikaz desnog video sadrzaja. Oznaka vremena nakon znaka
jednakosti (desna), ozna€ava duljinu vidljivoga, tj. prikazanoga video
sadrzaja.

Zadani prijelaz izmedu video sadrzZaja jest Dissolve, ali se on moze i
mijenjati u neki drugi. Za promjenu prijelaza potrebno je oznaditi prijelaz i
odabrati izbornik Properties u Toolbaru. U polju Video otvori se padajuci
izbornik gdje je moguce odabrati viSe od 20 vrsta prijelaza s njihovim
dodatnim opcijama. Za odabir prijelaza potrebno je samo odabrati neki iz
popisa i on ¢e se primijeniti na oznaceni prijelaz.

5.2. Dodatne mogucénosti video sadrzaja

Kako za zvuk, tako se i na video sadrzaje ili slike mogu primijeniti
tranzicije. Jedna od najces¢ih jest postupno prikazivanje ili postupno
nestajanje video sadrzaja.

Obi¢no se to radi na pocCetku video sadrzaja, tako da se postupno
prikazuje i na kraju postepeno nestaje. Nacin na koji se moze postaviti
postupno prikazivanije ili postupno nestajanje istovjetan je postupnom
pojaCavanju ili smanjivanju intenziteta zvuka kod audio sadrzaja.
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Potrebno je oznaditi video sadrzaj na kojem se Zeli omogucditi postupno
prikazivanje te se postaviti miSem u lijevi gornji kut video trake. Pojavit
¢e se treptajuci kruzi¢ kao $to je prikazano crvenim okvirom na donjoj
slici. Lijevom tipkom miSa pritisne se i drzi kruzi¢ te se povlaci u desnu
stranu video trake do Zeljenog vremena, koje se moze vidjeti na vrhu
Timelinea. Tako je primjerice moguce da od potpuno crne slike pa do
normalne prode nekoliko sekundi ili vise, ovisno o mjestu do kojeg ¢e se
povladiti tocka. Nakon odabira Zeljenoga vremena, pusti se lijeva tipka
misa.

> Ne@®@® S
|

Na donjoj slici moze se vidjeti izgled video trake u kojoj je postupno
prikazan video sadrzaj. Grafi¢ki je to prikazano sjenom koja je na
pocetku najdeblja, a prema kraju je sve tanja $to opisuje da se na
pocetku ne vidi nidta, tj. slika je najmracnija, a prema kraju je sve
svjetlija, do to¢ke gdje se spaja s izgledom originalnoga video sadrzaja.

v <> Neoed®® S
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Postupno nestajanje slike radi se po istom principu kao i postupno
prikazivanje, a obi¢no se stavlja na kraju video sadrzaja tako da slika ne
nestane naglo vec postepeno, kroz nekoliko sekundi. Na donjoj slici
moze se vidjeti izgled video trake u kojoj postupno nestaje video sadrzaj.
Graficki je to prikazano sjenom koja je na poc¢etku najtanja, a prema
kraju je sve deblja Sto opisuje da se na pocCetku normalno vidi video
sadrzaj, a prema Kkraju je sve tamniji pa sve do njegovog nestanka.
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5.2.1. Promjena brzine video sadrzaja preko izbornika
Properties

U programu Shotcut moguce je i kontrolirati brzinu reprodukcije video
sadrZaja preko izbornika Properties koji se nalazi u Toolbaru. Potrebno
je prvo oznaciti neki video sadrzaj u Timelineu i nakon toga pritisnuti na
izbornik Properties gdje je moguce vidjeti glavne informacije o
oznacenom video sadrzaju. Na donjoj slici moze se vidjeti primjer
izbornika Properties kada je oznaceni video sadrzaj
Sport_skejtbord.mp4.

Po standardnim postavkama, brzina video sadrZaja podeSena je na
»1,000 x“ pod oznakom Speed, prikazano crvenim okvirom na donjoj
slici. Ta vrijednost ozna€ava normalnu brzinu reprodukcije, tj. onu kojom
je i snimljen video sadrzaj. Kao $to je vidljivo iz donje slike, pokraj
oznake brzine reprodukcije nalazi se okretna dugmad za ubrzavanje i
usporavanje video sadrzaja.

Properties
Sport_skejtbord.mp4

Comrnents:

Speed = Apply Pitch Compensation

Duratio Timeline

Colorrange  Broadcast Limited (MPEG) ~

Rotation 0 =~ °

Ako se zeli dvostruko ubrzati neki video sadrzaj, potrebno je samo
brzinu namijestiti na ,,2,000 x“, okretnim dugmetom ili izravnim upisom
Zeljene vrijednosti u polje Speed. Nakon toga se u Timelineu moze
vidjeti da sadrzaj zauzima dvostruko manje mjesta od originalnog.
Razlog tomu je Sto se sadrzZaj prikazao za upola manje vremena.
Trajanje video sadrZzaja moze se jo$ vidjeti i u polju Duration, odmah
pokraj polja za podeSavanje brzine. Potrebno je oznaciti video sadrzaj
za koji se Zeli provijeriti trajanje. Na donjim slikama moze se vidjeti kako
dvostruko povecanije brzine utjeCe na video sadrzaj Potok.mp4.
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Timeline
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Nakon promjene brzine na ,2,000 x“, video sadrzaj ¢e trajati upola kracée
(Sto se moze vidjeti u polju Duration) i na Timelineu ¢e zauzimati
dvostruko manje mjesta, kao Sto se moze i vidjeti na donjoj slici.

Ako se video sadrzaj zeli vratiti na poCetne vrijednosti, potrebno je
odabrati u izborniku Properties dugme za prikaz dodatnih opcija

Properties Menu B te nakon toga pritisnuti na dugme Reset.

Dodatne informacije o video sadrzaju mogu se vidjeti na kartici Video u
istom izborniku Properties. Tako se u polju Codec moze vidjeti koji se
algoritam koristio u video sadrzaju. Polje Resolution je od velike vaznosti
jer pokazuje koja je rezolucija oznaenoga video sadrZaja. Ta je
informacija vazna na primjer prilikom montaze video sadrzaja, jer ako
ima vide video sadrzaja koji se trebaju spojiti u jednu cjelinu, a razli€itih
su rezolucija, konacan proizvod nece biti jednake rezolucije u svakom
svojem dijelu. Pojavljivat ¢e se crni rubovi sa svake strane kona¢noga
video sadrZaja ako neki video sadrzaj bude manji od ostalih ili obratno.
Frame rate oznaCava koliko kadrova, . sliica prikazuje video sadrzaj u
jednoj sekundi.

Pritiskom na dugme Properties Menu = pojavljuje se dodatni izbornik
u kojem se mogu odabrati joS neke naredbe za laksi rad s video
sadrZajem. Tako se moze pomocu naredbe Show in Folder brzo doci
do mape u kojoj se nalazi oznaceni video sadrzaj, naredbom Copy Full
File Path moguce je kopirati lokaciju, tj. putanju video sadrzaja na
racunalu. Za jo$ viSe informacija o video sadrzaju odabere se naredba
More Information, a za kontrolu i provjeru video sadrzaja odabere se
naredba Start Integrity Check Job. Rezultat provjere ispisuje se u
desnom gornjem kutu prozora, itd.
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5.3. Video i audio filtri

Filtri omogucuju promjenu video ili audio sadrzaja dodavanjem neke
odredene komponente sadrzajima, s ciliem poboljSanja sadrzaja. Tako
se moze video sadrzaju podesiti svjetlina, kontrast, moze mu se
promijeniti boja, moze ga se obrezati, zamultiti, promijeniti mu se
veli€ina, moze ga se rotirati i drugo. U audio sadrzaju moguce je
promijeniti glasno¢u zvuka, povecati bass, potpuno utidati zvuk na
odredenom dijelu, itd. Shotcut nudi mnogo filtara koji se odnose na video
i audio sadrzaj, a do svih je moguce dodéi preko izbornika Filters u
Toolbaru. Mnogi filtri imaju jo§ dodatni dijaloski okvir u kojemu se, prije
primjene, mogu podesiti razni parametri.

5.3.1. Video filtri

Za primjenu filtara na video sadrzaj ili sliku, potrebno je prvo oznaditi
Zeljeni sadrzaj i nakon toga odabrati Filters u Toolbaru. Za dodavanje

filtara potrebno je odabrati lijevom tipkom miSa dugme n Add a filter.
Otvara se izbornik u kojem se nude filtri za audio i video sadrzaje. Na
vrhu izbornika nalazi se pet dugmeta, a prikaz filtara koji se odnose
samo na video sadrzaje oznacen je crvenim okvirom na donjoj slici.

™ 15 - . = =
* Favorite [J video @ Audio @) Time = Sets

Prelaskom pokazivaCem misa preko bilo kojeg dugmeta, pojavit ¢e se

kratak opis njegove upotrebljivosti. Tako prvo dugme Show
favorite filters sluzi za brzi odabir naj¢eS¢e koristenih opcija, {j. filtara
koji su postali favoriti. Drugo dugme Show video filters
prikazuje samo filtre koji se odnose, tj. koji se mogu primijeniti na video
sadrzaje. Pritiskom na tre¢e dugme ICEEEE Show audio filters
prikazuju se samo filtri koji se mogu primijeniti na zvu¢ne datoteke.
Zadnja dva filtera Time i Sets sluZe za napredniju obradu video
sadrzZaja. 1z ovog izbornika moze se izaci pritiskom lijeve tipke misa

izvan tog otvorenog izbornika ili pritiskom na dugme H Close menu.

Primjerice, ako se Zeli promijeniti svjetlina slike ili video sadrzaja,
potrebno je odabrati Zeljeni sadrzaj na Timelineu i nakon toga odabrati
filtar Brightness do kojeg se dolazi preko izbornika Filters > Add a filter
- Show video filters - Brightness.

Filters

Video
¥  Brightness

100,0
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Nakon odabira, filtar ¢e se pojaviti ispod oznake Video, kao sto je
prikazano na gornjoj slici. Ispred njega se nalazi kvacica, koja oznaCava
da se taj filtar koristi, tj. da je aktivan. Filtar se moze iskljuciti tako da se
makne kvacica ispred njega. Trenutacna vrijednost svjetline sadrzaja
jest 100,0 % kao $to se moze vidjeti na gornjoj slici, a raspon u kojem se
moze korigirati svjetlina sadrzaja je od 0 % do 200 %. Ako se lijevom
tipkom misa povlaci plava linija prema 0 %, sadrzaj ¢e biti sve tamniji pa
sve do potpuno crne slike (0 %), a ako se plava linija povlaci prema 200
%, sadrzaj Ce biti sve svjetliji. Moguce je upisati i to€nu vrijednost u
postocima tako da se pritisne lijevom tipkom miSa u podrucje postotaka i
upiSe zeljena vrijednost svjetline u rasponu od 0 % — 200 %. Prilikom
promijene vrijednosti bilo kojim postupkom, rezultat se odmah vidi na
Vieweru.

Na isti se sadrzaj moze dodati viSe filtara te tako isti sadrzaj podesiti po
viSe parametara.

yess /Saturation

Na gornjoj slici moze se vidjeti vie primijenjenih filtara na video sadrza;j
Potok.mp4. Osim $to se filtri mogu iskljuciti tako da se makne kvacica
ispred pojedinog filtra, mogu se i izbrisati i kopirati. Odabirom dugmeta
Remove selected filter, filtar se briSe iz trenutacnog video sadrzaja.
A ako se kombinacijom filtara dobio Zeljeni konaéni proizvod i sad se
zele kopirati svi podesSeni filtri na neki drugi sadrzaj, odabere se dugme

Copy checked filters. Nakon toga se u Timelineu oznadi drugi

video sadrZaj ili slika i pritisne se na dugme ﬂ Paste filters. Svi filtri se
zalijepe na novi sadrzaj sa svim postavkama koje se mogu mijenjati po
potrebi.

Kada se slika ubacuje u Timeline, Cesto joj treba promijeniti dimenziju,
rotirati ju ili odrezati zbog toga jer ve¢inom nije iste dimenzije kao i video
sadrZaj u koji se ubacuje. Takve se akcije mogu takoder izvesti pomocéu
filtara koji se nalaze u video filtrima i mogu se primijeniti na sliku ili video
sadrzaj.

Za promjenu veli¢ine slike, pozicije ili rotaciju koristi se filtar Size,
Position & Rotate. Potrebno je oznaditi sliku u Timelineu i odabrati filtar
Filters > Add a filter > Show video filters > Size, Position & Rotate i
nakon odabira upisati Zeljenu vrijednost za neku od ponudenih opcija u
dodatnim moguénostima filtera.
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Crvenim okvirom na gornjoj slici, oznaceno je podrucje dodatnih opcija
filtra. U ovom slu€aju moguce je promijeniti poziciju multimedijskog
sadrzaja tako da se upiSe vrijednost za X ili Y os u polje Position,
promijeniti veli¢inu upisom vrijednosti u polje Size, zumirati sadrzaj
povlacenjem linije ili upisom vrijednosti u polje Zoom, u polju Size mode
postaviti sadrZzaj da se prikazuje u jednoj od tri ponudene veli€ine,
poravnati multimedijski sadrzaj po vodoravnoj ili okomitoj osi odabirom
jedne od ponudenih opcija u polju Horizontal fit i Vertical fit, rotirati sliku
ili neki drugi multimedijski sadrzaj tako da se upiSe konkretna vrijednost
u polje Rotation ili se povladi lijevom tipkom misa linija koja ¢e se pojaviti

unutar tog polja. Pored svakog polja nalazi se jo$ i dugme 2l Reset to
default Cijim se pritiskom to polje vraca na zadane, pocetne postavke.

Dugme E Use Keyframes for this parameter nalazi se pored
pojedinih opcija na kojima se moze postaviti keyframe i pomocu kojeg se
moze primjerice u ovom konkretnom filtru to€no na odabranom vremenu
multimedijskog sadrzaja u Timelineu promijeniti veli¢ina multimedijskog
sadrzaja ili zarotirati multimedijski sadrzaj (zato $to se samo pokraj tih
opcija nalazi moguénost postavljanja keyframea) Vise informacija o
keyframeovima obradit ¢e se u sljede¢em poglavlju.

Za rezanije slike koristi se filtar Crop: Source. Potrebno je oznaditi sliku
u Timelineu i odabrati filtar Filters > Add a filter > Show video filters >
Crop: Source. U dodatnim opcijama filtra, sadrzaj se moze rezati s
gornje strane (Top), s donje strane (Bottom), s lijeve strane (Left) i s
desne strane (Right), povlacenjem plave linije ili izravnim upisom
vrijednosti u pikselima u rasponu od 0 px pa sve do visine ili Sirine
oznafenoga sadrzaja. Ispred tih opcija nalazi se jo$ jedna korisna
naredba Center kojom je moguce postaviti sadrzaj u centar tako da se
stavi kvacica ispred te naredbe.
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5.3.2. Audio filtri

Audio filtri se na isti nacin primjenjuju na audio sadrzaj kao i video filtri
na video sadrzaj. Potrebno je oznaciti audio sadrzaj na koji se zeli
primijeniti neki filtar i nakon toga odabrati zZeljeni filtar.

Dva su filtra Cesto koriStena u audio sadrzajima, Fade In Audio i Fade
Out Audio.

Dexter_Britain_-_07_-_The_Time_To_Run.mp3
Audio
v  Fade In Audio
v  Fade Out Audio

g -

Duration

Fade In Audio sluzi za postupno pojacavanje audio sadrzaja iz najtiSe
prema originalnoj glasno¢i audio sadrzaja. Fade Out Audio postavlja se
na kraj audio sadrZaja gdje se postupno stiSava zvuk iz originalne
glasnoce zvu€noga sadrzaja do potpune tiSine. U dodatnim opcijama
filtra, u polju Duration, moguce je upisati koliko ¢e taj prijelaz trajati.
Zadana vrijednost je jedna sekunda, a pritiskom na dugme plus ili minus,
ili izravnim upisom neke druge vrijednosti, vrijeme prijelaza moze se
produZiti ili skratiti.

Uz mnos&tvo ponudenih korisnih filtara, ¢esto koristeni su joS§ i
Gain/Volume i Mute.

Ako je audio sadrzaj iz nekog razloga previSe glasan ili previse tih, moze
se pokusati popraviti glasno¢a sadrzaja pomodu filtra Filters > Add a
filter > Show audio filters > Gain / Volume. U dodatnim opcijama filtra,
audio sadrzaju se moze korigirati glasno¢a od -70 dB do 24 dB, izravnim
upisom vrijednosti u polje Gain ili pomicanjem plave linije ljevom tipkom
misa.

Kada se treba potpuno utiSati dio audio sadrzaja ili cijeli audio sadrzaj,
primjenjuje se filtar Filters > Add a filter > Show audio filters - Mute.
Potrebno je samo oznaciti audio sadrZaj na koji se Zeli primijeniti ovaj
filtar te ga odabrati.

5.4. Kiljuéni kadrovi ili keyframeovi

Jedna od najtrazenijih zna€ajka u alatu za obradu multimedijskih
sadrZaja je svakako sposobnost glatkog pomicanja ili zumiranja slika ili
digitalnih fotografija. Tako se iz neke statiCke slike dobiva dinami¢na
animacija. Ujedno, otvara se moguc¢nost da se na jednostavniji nacin
postavi trajanje efekta na bilo kojem multimedijskom sadrzaju. Sve to se
postize tako da se parametri filtra pomocu keyframeova animiraju u
novoj kartici Keyframes koja se nalazi na dnu Timelinea. Na donjoj slici
oznacena je crvenim okvirom kartica Keyframes kojom se ukljucuje
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prazna plo€a u koju je moguce dodavati keyframeove nakon uklju€ivanja
Zeljenog filtra.

Primjerice, ako se Zeli iz neke statike slike ili fotografije izraditi neka
dinami¢na animacija, prvo je potrebno dodati odabranu sliku u Timeline.
Nakon dodavanja, prema zadanim postavkama programa slika ima
trajanje od 4 sekunde. S obzirom na to da e se izraditi dinami¢na
animacija iz dodane slike, dobro je produljiti vrijeme prikazivanja slike.
Na donjoj slici vidi se dodana slika Hrana.png kojoj je produljeno
trajanje s Cetiri na dvadeset sekundi.

E XEW =~ vi v <> Ne@@® S

Recimo da se ne zeli prikazati odmah svih pet tanjura s hranom, ve¢ se
zele prikazati uvecéani tanjuri koji e se pomicati s desne na lijevu stranu.

Nakon dodavanija slike u Timeline, potrebno je postaviti filter kojim je
moguce promijeniti veli€inu slike i poziciju slike. Oznaci se slika u
Timelineu, te se odabere filter Filters - Add a filter > Show video filters
- Size, Position & Rotate. Nakon primjene filtra, potrebno se prebaciti
na karticu Keyframes, koja nije viSe prazna kao $to se moze vidjeti na
donijoj slici, ve¢ ima stvorenu traku s nazivom dodanog filtra.

Sada je potrebno odabrati keyframe iz Zeljene skupine u filtru, ovisno o
tome koji ¢e se parametar Koristiti.
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Na gornjoj slici oznaceni su crvenim okvirom dva keyframea koja je
moguce Koristiti. Prvi parametar keyframea se odnosi na skupinu
Position, Size i Zoom, a drugi parametar koji se moze postaviti, odnosi
se na Rotation. Moze se Koristiti odjednom viSe keyframeova iz
pojedinog filtra, ali da bi sliku uvecali i mijenjali joj poziciju, potrebno je
odabrati prvi keyframe. Prije samog odabira keyframea, potrebno se
pozicionirati pomocu Playheada na mjesto gdje ¢e se postaviti prvi
keyframe. U ovom slucaju, potrebno se postaviti na pocetak i tu postaviti
prvi keyframe tako da se pritisne na ikonu Use Keyframes for this
parameter E zeljenog parametra. Kako se zeli postupno zumirat slika i
ujedno mijenjat njena pozicija, za taj prijelaz ¢e se postaviti sljededi
keyframe na Cetvrtoj sekundi. Postavi se Play-head na Cetvrtu sekundu i
odabere ikona Bl Add a keyframe at playhead, na kartici Keyframes u
traci Size & Position, kao Sto je prikazano na donjoj slici.

Na traci Size & Position nalaze se sada dva keyframea, poCetni, na
kojem ¢&e se prikazati originalna slika onako kako je i dodana te drugi
keyframe na kojem se postavlja Zeljeno zumiranje i nova pozicija slike.
Nakon postavljanja tih parametara, program ¢e sam izraditi glatku
animaciju izmedu pocetnog keyframea i sliedeéeg po redu, u gornjem
sluc¢aju drugog po redu.

Na drugom keyframeu postavi se zumiranje (polje Zoom u filtru Size,
Position & Rotate) na 270%, a pozicija se podesi ru¢no u Pregledniku
(engl. Viewer). Drzanjem tipke [Shift] na tipkovnici i pritiskom lijeve tipke
misa na slici moguce je pomicati sliku po Pregledniku, drZzanjem tipke
[Ctr1] slika se moZe rotirati, a kotaCicem na midu slika se mozZe zumirati.
Potrebno je namjestiti sliku tako da su vidljiva samo prva dva tanjura s
hranom u Pregledniku, kao §to je prikazano na donjoj slici.




Zanimljivosti i napomene

Prilikom pomicanja slike na
4. keyframeu, moze doci do
pomaka u okomitoj osi.
Potrebno je samo u filtru
vidjeti polje Position koja je
vrijednost za okomitu os na
3. keyframeu te tu istu
vrijednost upisati i na 4.
keyframeu kako se slika ne
bi micala po okomitoj osi
prilikom pomicanja.
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Ako se video sadrzaj pokrene iz poCetka, moze se vidjeti rezultat ova
dva keyframea. Nakon zumiranja slike, neka ostane na mjestu jednu
sekundu. Prije nego se krene u animiranje ostalog sadrzaja, potrebno je
obrisati zadnji keyframe jer je na njemu zabiljezena stara pozicija i staro
zumiranje slike. Oznaci se zadnji keyframe i pritisne na ikonu £l Delete
the selected keyframe, nakon ¢ega je moguce vidjeti da se u
Pregledniku sadrzaj podesio na istu poziciju i zumiranje kao i kod drugog
keyframea. Nakon toga se oznaci drugi keyframe i pomakne se
Playhead za jednu sekundu dalje od drugog keyframea, na 5. sekundu.
Na tom mjestu stvori se treci keyframe.

Izmedu treceg i Cetvrtog keyframea ¢e se pomicati tanjuri iz desne na
lijevu stranu pa je potrebno ostaviti dovoljno vremena da se svi tanjuri
prikazu. Tako ¢e se 4. keyframe postaviti na petnaestu sekundu gdje je
potrebno pomaknuti sliku tanjura do posljednja dva tanjura, kao $to je
prikazano na donjoj slici.

Peti keyframe se postavlja na Sesnaestu sekundu bez ikakvih
intervencija, tako da animacija stoji jednu sekundu.

Zadniji keyframe postavlja se na kraj slike i na njemu se podesi slika kao
i na prvom keyframeu, tako da se dobije efekt kako se slika odzumira i
vraca na pocetno stanje. Izgled svih postavljenih keyframeova koji ¢ine
dinami¢nu animaciju prikazan je na donjoj slici.

U podrucju Toolbara, nalazi se Layout u kojem je moguée promijeniti
izgled programa. Ako se pritisne na dugme FX, program se prebacuje u
izgled namijenjen za laksi rad s efektima, gdje se na istom prikazu
nalaze kartice Keyframes, Timeline, Filters, Playlist i Viewer, odnosno
sve potrebne kartice za izradu nekog efekta ili primjenu filtra na odredeni
video sadrzaj. Nakon zavrSetka, moze se opet vratiti u izgled Editing.
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5.5. Vjezba: Postavljanje animacija i efekata na
video sadrzaj

1. Umetnite sedam multimedijskih sadrZaja u Playlist o
Zanimljivosti i napomene

programa Shotcut. Potok.mp4, Slap.mp4,
Sport_rolanje.mp4, Kava.mp4, Dexter_Britain_- 01_- Kako bi izbjegli neZeljeno
_Seven.mp3, Vodopad.png i More.png. pona$anje programa u
smislu da program

2. Ubacite u Timeline video sadrzaje Potok.mp4, Slap.mp4, zablokira, pozelino je prije

Kava.mp4 i Sport_rolanje.mp4, to¢no tim redoslijedom. izvedbe bilo koje viezbe il
Pomaknite video sadrzaje jedan do drugoga i promijenite projekta ugasiti i ponovno
naziv video trake iz ,V1“ u ,Video prijelazi“. upaliti program.

3. lzmedu video sadrzaja Potok.mp4 i Slap.mp4 napravite
Dissolve prijelaz u trajanju od 3 sekunde. Ponovite isti
prijelaz s istim trajanjem izmedu video sadrzaja Slap.mp4
i Kava.mp4. Izmedu video sadrZaja Kava.mp4 i
Sport_rolanje.mp4 napravite prijelaz Bar Horizontal od
2 sekunde.

4. Napravite postupno prikazivanje prvoga video sadrzaja
Potok.mp4 u trajanju od 3 sekunde.

5. Napravite postupno nestajanje zadnjega video sadrzaja u
nizu Sport_rolanje.mp4 u trajanju od 4 sekunde.

6. Duplo ubrzajte video sadrzaj Kava.mp4 tako da postavite
brzinu na 2,000 x u izborniku Properties u polju Speed.
ObriSite novonastalu prazninu tako da su opet svi video
sadrzaji spojeni u jedan niz.

7. Na video sadrzaj Kava.mp4 postavite filtar Old Film:
Dust koji se nalazi u izborniku Filters.

8. Dodajte u Timeline novu video traku pomocéu naredbe
Add Video Track i promijenite joj naziv u ,Slike“. Ubacite
u nju slike Vodopad.png i More.png. Slike se trebaju
poceti prikazivati nakon zavrSetka prikaza video sadrzaja i
trebaju biti postavljene jedna do druge.

9. Na sliku Vodopad.png postavite filtar Size, Position &
Rotate i zumirajte sliku upisom 120 % u polje Zoom. Na
kartici Keyframes napravite postupno prikazivanje i
postupno nestajanje filtra Zoom, u trajanju od jedne
sekunde. Vratite se ponovno u Timeline.

10. Na sliku More.png postavite filtar Crop: Source.
Potrebno je pribliziti to¢no odredeni dio slike pa u
dodatnim postavkama filtra postavite polje Top na 420 px
i polje Right na 670 px.

11. Dodajte audio traku i promijenite joj naziv u ,Pozadinska
glazba“. Ubacite zvuénu datoteku Dexter_Britain_-_01_-
_Seven.mp3 u audio traku i poravnajte ju da po¢ne od
pocletka, odreZite ju do duljine trajanja posljednje slike te
obriSite ostatak.
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12. Postavite filire Fade In Audio i Fade Out Audio na
zvu€nu datoteku Dexter_Britain_- 01_- Seven.mp3 i u
dodatnim opcijama, u polju Duration, podesite trajanje
svakog filtra na 3 sekunde.

13. Spremite projekt pod nazivom Projekt_3.milt i pregledajte
cijeli sadrzaj.
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6. Rad s tekstom -

Trajanje
Po zavrsetku ovoga poglavija moci cete: poglavlja:
e umetnuti tekst u obliku slike u video 30 min

o umetnuti i oblikovati tekst uporabom filtara.

Klju¢na komponenta, osim slike i zvuka, koja daje kona¢nom video
sadrzaju neki zavrsni oblik jest tekst. Tekst se u vecini video sadrzaja
koristi samo na pocetku i na kraju video sadrzaja, ali u nekim situacijama
potrebno ga je postaviti i tijekom trajanja video sadrzaja.

U programu Shotcut tekst se dodaje preko filtara, a moguce je dodati
obi¢an ili 3D tekst. Postavlja se na bilo koji video sadrza; ili sliku §to ¢e
biti prikazano u nastavku. Tekst se moze umetnuti na dva nacina. Prvi
nacin jest umetanje u video traku unaprijed napisanoga teksta u obliku
slike, a drugi jest upisivanje teksta na sdm video sadrzaj ili sliku.

6.1. Umetanje teksta u obliku slike u video

Kada se umece slika koja ima ulogu naslova ili zahvale na nekom video
sadrZaju, najbolje je da ona bude istih dimenzija kao i video sadrza;.
Tako se najmanje gubi kvaliteta teksta na slici i nee se primijetiti
prijelaz iz slike u video sadrzaj. Slika se moze izraditi u bilo kojem
vektorskom ili rasterskom programu (Inkscape, lllustrator, GIMP,
Photoshop itd.), a najbolje ju je spremiti u PNG format i kao takvu uvesti
u Shotcut.

Slika koja u sebi sadrzi pozadinu umece se prije poCetka video sadrzaja,
tako da se prvo vide informacije sa slike i nakon toga s prikazivanjem
zapocinje video sadrzaj. Potrebno je samo iz kartice Playlist ubaciti sliku
u Timeline ispred prvog video sadrzaja kao $to je i prikazano na donjoj
slici.

Ne@E®® S

Output 0 ‘ 00:00:10

Znamenitosti s

g o

U ovom slu€aju prvo se prikazuje slika s natpisom ,Kip slobode® koja
ima i neku pozadinu. Trajanje prikazivanja naslova iznosi otprilike pet
sekundi i nakon toga se prikazuje video sadrzaj ,Kip slobode.mp4*.

Kako je tekst naslova zapravo slika, znaci da se na nju mogu primijeniti
svi filtri kao i na video sadrzaj. Naslov Ce izgledati puno atraktivnije ako
se postave na njega neki filtri. Tako se moze postaviti da se postupno
prikazuje na pocetku i da ima prijelaz izmedu naslova i video sadrzaja,
Sto je prikazano na donjoj slici.
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Slika moze biti i transparentna pa se samim time moze prikazivati
istovremeno s video sadrzajem. To se koristi kada se Zele objasniti neki
video segmenti dodatnim opisom u obliku teksta ili se Zeli naslov
postaviti tako da se vidi i video sadrzaj.

Za takav prikaz teksta potrebno je transparentnu sliku s tekstom
postaviti u novu video traku, iznad video sadrzaja na kojem se zeli
prikazati taj tekst. Nakon toga je potrebno samo odrediti vrijeme trajanja
prikaza teksta, tj. slike.

> Ne*e@@® S

Na gornjoj slici prikazan je izgled Timelinea gdje se u prvoj video traci
»lransparentan tekst“ nalazi slika s natpisom Kip slobode koja je
transparentna, a u donjoj traci ,Znamenitosti“ istovremeno se
reproducira video sadrzaj Kip slobode.mp4.

Na gornjoj slici moZe se vidjeti izgled teksta, tj. transparentne slike
postavljene na video sadrzaj. Ako se naslov zeli smanijiti ili premjestiti na
neku drugu poziciju, potrebno je samo na tu transparentnu sliku postaviti
filtar Size and position u kojem je moguce promijeniti veli€inu ili poziciju
slike &to je opisano u poglavlju 3.3.1 Video filtri. Prednost ovakvoga
nacina umetanja teksta jest ta Sto se na sliku mogu postaviti i drugi filtri
te samim time naslov moze izgledati atraktivnije, postupno se pojaviti ili
nestati, posvijetliti se ili potamniti, promijeniti boju itd.
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Kip slobode_transparentna.png

Cesto se na transparentnoj slici naslova koriste filtri Fade In Video i
Fade Out Video za postupno pojavljivanje i postupno nestajanje slike, t;.
naslova. PoCetne postavke filtra postupno prikazuju sliku od crne boje,
znaci da se slika pojavljuje s crnom bojom i isto tako postupno nestaje s
crnom bojom $to ne izgleda lijepo jer se prvo pojavi crni tekst i od toga
se postupno pojavljuje boja teksta koja se nalazi na slici, {j. koja je
odabrana. Za izbjegavanje toga, potrebno je u dodatnim opcijama filtra
staviti kvacCicu na naredbu Adjust opacity instead of fade with black,
oznacenu crvenim okvirom na gornjoj slici. Nakon toga, slika ¢e se iz
nevidljive postupno pojavljivati i postupno nestajati do nevidljivosti bez
dodatka crne boje.

6.2. Umetanje teksta u video uporabom filtra

Tekst je moguce ubaciti i preko filtra, izravno na video sadrza;j ili sliku.
Postoje dva filtra za tekst, prvi je jednostavniji pod nazivom Text:
Simple, dok se s drugim, koji se naziva Text: Rich, moze direktno pisati
po video sadrzaju u podrucju Viewera (Preglednika), ima plutajucu
alatnu traku i sprema se u projektnu datoteku. Za uporabu ovih filtara,
potrebno je oznaditi Zeljeni video sadrzaj ili sliku na Timelineu i odabrati
na izborniku Filters u polju Show video filters jednu od naredbi, u ovom
slu¢aju Tekst: Simple.

Kip slobode.mp4

7 Text: Simple

Insert field | # (Hash sign)

|

U dodatnim opcijama filtra Tekst: Simple, prva je naredba iz popisa
Preset koja omogucuje podeSavanje teksta po nekim ve¢ unaprijed
definiranim postavkama. Kada se pritisne strelica za prikaz padajuceg
izbornika, pojavit ¢e se naredbe Defaults, kojom se tekst vra¢a na
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Zanimljivosti i napomene

Veli¢ina fonta ne moze se
mijenjat u izborniku Font.
Za promjenu veli¢ine fonta
koristi se polje Size koje je
obiéno podeSeno na
veliinu ubacenog
multimedijskog sadrzaja
(npr. 1920 x 1080).

pocCetnu vrijednost, Bottom Left kojom se tekst postavlja u doniji lijevi kut,
Bottom Right kojom se tekst postavlja u donji desni kut, Lower Third
kojom se tekst postavlja u donju trecinu, na dnu padajuéeg izbornika
nalaze se joS Top Left kojom se tekst postavlja u gorniji lijevi kut i Top
Right kojom se tekst postavlja u gornji desni kut. Ostale naredbe imaju
ispred svog nazive Slide ili Slow i sluze za animiranje teksta. Potrebno je
samo odabrati jednu od naredbi i tekst ¢e biti animiran odabranom
naredbom. Kada se odabere bilo koja od tih naredbi, moZe se odmah
vidjeti promjena u polju Position i Size, gdje se ispisuje koordinata teksta
i trenutacna veli¢ina. U polju Size moguce je upisati Zeljenu veli€inu
teksta, prvo polje se odnosi na Sirinu, a drugo na visinu teksta.
Horizontal fit i Vertical fit omogucuju poravnanje teksta po vodoravnoj ili
okomitoj osi u nekoliko ponudenih opcija.

Drugo polje Text sluzi za upis teksta koji se Zeli prikazati na video
sadrzaju ili slici. Po po€etnim postavkama postavljeno je polje u kojem
se na video sadrZaju prikazuje tekst jednakoga trajanja kao i video
sadrzaj, #timecode#, a koji se moze obrisati i upisati neki drugi tekst.
Ovisno o koli€ini upisanoga teksta mijenja se i njegova veli¢ina na
prikazu — Sto je viSe teksta, to je veliCina manja i obratno. Ako Zelimo da
tekst bude odredene veli€ine, upiSe se Zeljeni broj piksela za visinu i
Sirinu. Osim upisom veli€ine u polje Size, veliina teksta moze se
promijeniti i u podrucju prikaza video sadrzaja. Potrebno je miSem
uhvatiti bilo koji kut prikaza videa i pomicati ga. Na sredini okvira nalazi
se tocka koja oznaCava centar tekstualnog okvira. Pritiskom na nju
lijevom tipkom miSa, moze se pomicati tekstualni okvir na Zeljenu
poziciju na video sadrzaju ili slici. Na gornjoj slici crvenim okvirom je
oznaceno podrucje gdje se moze mijenjati boja teksta, font teksta, boja
obruba teksta, veli€ina obruba, boja pozadine teksta i razmak od ruba
okvira.

Za promjenu fonta potrebno je samo kliknuti na dugme u polju Font na
kojem je ispisan trenutacni font. Otvorit Ce se dijalo$ki okvir Please
choose a font u kojem se u podruc¢ju Font moZe odabrati Zeljeni.
Dovoljno je odabrati Zeljeni font iz popisa i pritisnuti dugme OK. Pored
dugmeta za odabir fonta nalazi se padajuci izbornik u kojem je moguce
odabrati oblikovanje fonta izmedu opcija Normal, Bold i Light.

Debljina obruba teksta mijenja se okretnim dugmetom ili izravnim
upisom vrijednosti u polju Thickness. Razmak, tj. odmak od rubova
upisuje se ili se odabire okretnim dugmetom u polju Padding.

Tekst upisan preko filtra primjenjuje se na cijeli oznageni video sadrzZa;j ili
sliku. Za primjenu samo na pocetku, na kraju ili na nekom odredenom
dijelu video sadrzaja ili slike, potrebno je odrezati video sadrzaj ili sliku
(pritiskom na dugme Split At Playhead) u Zeljenom trajanju i samo na
taj dio postaviti filtar teksta.

Timeline
S @l F=AvI v ANe@®® S

Output |oc:00.05 |oc:00:10
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o
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Na gornjoj slici moze se vidjeti odrezani video sadrzaj za potrebe
postavljanja naslova na njega. U konacnoj reprodukciji ne¢e se primijetiti
prijelaz tog odrezanog dijela, a tekst ¢e se prikazati samo na sekciji, {j.
video sadrzaju na koji se postauvi filtar teksta. U gornjem slu€aju tekst je
postavljen na prvi dio video sadrzaja, koji je i oznacen, i prikazan je
samo za trajanja toga dijela video sadrzaja, malo viSe od 4 sekunde, a
nakon toga tekst nestaje i video se nastavlja reproducirati.

Nedostatak prethodno opisanoga nacina jest nemogucénost postupnoga
prikazivanja ili postupnoga nestajanja teksta. To je moguce rijesiti na
drugi nacin, koji zahtijeva malo viSe koraka.

Prvi korak jest dodavanje Zeljenoga video sadrzaja ili slike u Timeline.
Nakon toga, potrebno je odrezati video sadrzaj ili sliku do Zeljenog
trajanja prikazivanja teksta.

Timeline
S Yl k=AvINeO® S

Output

Znamenitosti

g Y o

Na gornjoj slici vidi se video sadrzaj ,Kip slobode.mp4“koiji je odrezan
nakon prvih pet sekundi, koliko ée trajati i naslov. Nakon toga, potrebno
je izraditi novu video traku i na nju kopirati taj prvi dio video sadrzaja i
postaviti ga to¢no na mjesto gdje se nalazi i izvorni dio video sadrzaja,
kao $to je i prikazano na donjoj slici.

N Rl E=AvI P <> Ne@®O®

S\
|oeoe-10

10

Na video sadrzZaj u prvoj video traci Tekst dodaje se zeljeni tekst. Taj
tekst se sada takoder prikazuje po cijelom video sadrzaju, ali sada taj
video sadrzaj traje samo 5 sekundi. Za postupno pojavljivanje ili
postupno nestajanje teksta, potrebno je samo na taj video sadrzaj
postaviti filtre Fade In Video i Fade Out Video. Konacan rezultat bit ¢e
kao da se samo tekst pojavljuje i nestaje, a ne i video sadrzaj s njim.

Istim postupkom moguce je dodati tekst na bilo kojem dijelu video
sadrzaja i postici jednak efekt.
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6.3. Umetanje teksta u video pomocu kartice
Keyframes i prikaza FX

Na jos jedan nacin je moguce postici sliCan efekt pojavljivanja i
nestajanja teksta, bez potrebe za rezanjem multimedijskog sadrzaja u
dijelu gdje se zZeli ubaciti tekst. Potrebno je samo na zeljeni multimedijski
sadrzaj primijeniti odredeni filter, u ovom slucaju filter Text: Simple.
Radi vece kontrole nad filterom i radi lakSeg snalazenja, odabere se u
podrucju Toolbara izgled programa namijenjen za rad s efektima, tako
da se pritisne na dugme FX (Switch to the effects layout). UpiSe se
Zeljeni tekst na isti nacin kao i u prethodnom primjeru, promijeni boja,
podesi poravnanje, itd. Na donjoj slici moze se vidjeti naslov i program u
FX izgledu programa.

@ %=~ I

U filtru Text: Simple, odabere se u Preset polju proizvoljan efekt koji
ima ispred naziva Slide ili Slow. Potrebno je odabrati ulazni i izlazni
efekt. Tako se u donjem primjeru odabrao ulazni efekt Slide In From
Left i nakon toga se samo u izborniku Preset na isti nain odabere
izlazni efekt, u donjem slu€aju Slide Out Right. Nakon toga je potrebno
opet podesiti poravnanje i boju teksta ako se to ve¢ odradilo prije
postavljanja ulaznog i izlaznog efekta.

Na kartici Keyframes potrebno je pomocu pocetne zelene i zavrsne
crvene linije odrediti u kojem rasponu ¢e biti vidljiv odredeni efekt.
Pritisne se i drzi lijevom tipkom miSa na odabranu liniju i odvuce na
Zeljeno mjesto. Nakon toga, pomocéu kruzi¢a za postupno pojavljivanje i
nestajanje, odreduje se trajanje ulaznog i izlaznog efekta.

Na gornjoj slici moze se vidjeti da je poCetna zelena linija na samom
pocetku video sadrzaja i postupno se pojavljuje efekt za prikaz teksta
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Slide In From Left. Crvena linija nalazi se na nekih pet sekundi videa i
postupno nestaje tekst s efektom Slide Out Right. Imena efekta na
kartici Keyframes se ne vide, jer su oni predefinirani na po€etku u polju
Preset.

Na taj nacin je moguce na laksi i jednostavniji nacin prikazati tekst na
multimedijskom sadrzaju, na bilo kojem mjestu unutar multimedijskog
sadrzaja.
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Zanimljivosti i napomene

Ako zadnje slovo izlazi iz
podrucja vidljivosti u
Pregledniku, dodaje se na
kraju teksta ,razmak®.

To se dogada zbog /talic
oblikovanja fonta, gdje
program ne prepoznaje
problem i u tom slu€aju ne
prosiruje tekstni okvir.

6.4.

Vjezba: Postavljanje teksta na video sadrzaj

1.

Umetnite tri multimedijska sadrzaja u Playlist programa
Shotcut. Utvrda.mp4, Pticja perspektiva.mp4 i Utvrda
na planini transparentna.png.

Ubacite u Timeline video sadrzaje Utvrda.mp4 i Pticja
perspektiva.mp4, tocno tim redoslijedom. Pomaknite
video sadrZaje jedan do drugoga i promijenite naziv video
trake iz ,V1“ u ,Video sadrzaji“. Izmedu video sadrzaja
Utvrda.mp4 i Pticja perspektiva.mp4 napravite
Dissolve prijelaz u trajanju od dvije sekunde.

Dodajte u Timeline novu video traku pomocu naredbe
Add Video Track i promijenite joj naziv u ,Tekst".
Ubacite u nju sliku Utvrda na planini transparentna.png
i napravite postupno prikazivanje slike i nestajanje u
trajanju od jedne sekunde. Postavite ju na pocetak prvoga
video sadrzaja i produljite joj trajanje na pet sekundi.

Na pocetku video sadrzaja Pticja perspektiva.mp4
postavite naslov ,More i oblaci“ pomocu filtra Text:
Simple u trajanju od pet sekundi. Napravite postupno
prikazivanje teksta efektom Slide In From Top i postupno
nestajanje teksta efektom Slide Out Bottom u trajanju od
jedne sekunde u prikazu FX. Font naslova je ,Monotype
Corsiva“, boja ,,#55ffff* u HTML obliku. Tekst postavite
na sredinu tako da u polju Vertical Fit odaberete opciju
Middle.

Spremite projekt pod nazivom Projekt_4.mlt i pregledajte
cijeli sadrzaj.
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7. Spremanje i objava video sadrzaja

Po zavrsetku ovoga poglavija moci Cete:

e odabrati odgovarajuce predefinirane postavke izvoza video
sadrzaja (npr. YouTube)

e razlikovati najcesce koriStene formate video sadrzaja
e dodatno prilagoditi predefinirane postavke
e jzvesti video sadrZaj.

Nakon zavrSenog projekta u programu Shotcut potrebno je namjestene
multimedijske sadrzaje pretvoriti u neki prepoznatljiv i dostupan format,
tako da ga mogu vidjeti i oni koji nemaiju instaliran Shotcut na svojem
racunalu. Program Shotcut nudi velik broj video formata u koje je
moguce izvesti izradene projekte, a najéesce koristeni spomenut ¢e se u
nastavku.

7.1. lzvoz video sadrzaja

Montaza video sadrzaja ukljuCivala je rezanje, dodavanje video i audio
sadrzaja u Timeline, dodavanje animacija, teksta, pa je potrebno sve te
elemente koji se nalaze u Timelineu spoijiti u jedan video sadrzaj. Da bi
se to postiglo, potrebno je izvesti sadrzaj Timelinea (engl. Export) u neki
prepoznatljivi format kao $to je mp4, avi, mov, mpg, wmv i dr.

7.1.1. Video formati

MP4 je skracenica od MPEG-4 Part 14. Ta se tehnologija temelji na
Appleovom QuickTime MOV formatu, ali koristi podr8ku iz mnogih
MPEG dijelova. Datoteka je prvi put objavljena 2001., ali ponovno
objavljen format iz 2003. jest onaj koji se danas koristi za MP4 datoteke.
Mnogi misle da je MP4 samo novija verzija MP3 datoteke, ali to nije
istina. Najveca razlika izmedu MP3 i MP4 formata jest u vrsti informacija
koje sadrze. MP3 se moze koristiti samo za zvu¢ni sadrzaj, dok se MP4
datoteke koriste za zvuk, video, slike, titlove i tekst. MP4 datoteke su
zapravo "kontejneri", $to znaci da pohranjuju i mnogo drugih podataka
osim same datoteke. Upravo zbog toga nemaju univerzalni nacin
koristenja kéda datoteke pa su za deSifriranje informacija koje se nalaze
u MP4 "kontejneru" potrebni Codeci. Danas postoje stotine razlicitih
codec formata, no nisu svi kompatibilni s MP4 playerima. Kako bi neki
player mogao ucitati MP4 datoteku, mora imati isti codec format kojim je
i sama MP4 datoteka snimljena. NajraSireniji codec formati za video jesu
MPEG-4 Part 10 (H.264) i MPEG-4 Part 2, za audio AAC, ALS, SLS,
TTSI, MP3, a za titlove MPEG-4 Timed Text.

AVI (Audio Video Interleaved) se takoder sastoji od multimedijskog
kontejnera koji mozZe imati zvucni i video sadrzaj, $to omogucuje
sinkroniziranu reprodukciju zvuka i slike. To je format predstavljen od

Trajanje
poglavija:

20 min

Zanimljivosti i napomene

MP3 datoteke ¢e uvijek biti
manje nego MP4 datoteke,
jer zapisuju samo zvuk.
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strane Microsofta u studenom 1992. godine kao dio njihove Video for
Windows tehnologije.

MOV datoteka se takoder sastoji od multimedijskog kontejnera,
razvijenog od strane Applea, a kompatibilnoga na platformama
Macintosh i Windows. MOV obi¢no koristi MPEG-4 codec za kompresiju
video sadrzaja. Zanimljivo je da se MOV datoteke mogu vrlo lako
konvertirati u MP4 datoteke kao i MOV audio datoteka u poznatiji OGG
format pomocu obi¢noga VLC media playera.

7.1.2. lzvoz projekta

Za izvoz projekta potrebno je pritisnuti dugme Export koje se nalazi u
Toolbaru.

Presets

Export Help

Configure...

Export File

Flaylist Filters Properties Export

Otvara se dijaloski okvir Export u kojem je moguce odabrati razne
postavke za izvoz video sadrzaja. U lijevom dijelu dijaloskog okvira
Presets, oznaCenom crvenim okvirom na gornjoj slici, nalaze se vec
predefinirane postavke za izvoz video sadrzaja koje se primijene
pritiskom na Zeljenu opciju iz izbornika. Ponuden je velik broj
predefiniranih postavki, a u slu¢aju da ni jedna nije zadovoljavajuca,
moguce je izravno upisivati vrijednosti u desni dio dijaloSkog okvira ako
se pritisne na dugme Advanced te tako stvoriti jedinstvene postavke.

Timeline

Playlist

Each Playlist [tem

Source

U desnom dijelu dijaloSkog okvira, u polju From prikazanom na gornjoj
slici, moguce je odabrati dio koji se zeli izvesti. Ponudene opcije u
padajuc¢em izborniku jesu: Timeline, Playlist, Each Playlist ltem i Source.
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e Timeline znadi da ¢e se izvesti sve $to se nalazi na Timelineu i iz
toga izraditi jedan video sadrza;.

e Opcijom Playlist izvest Ce se svi video sadrzaji i slike koje se
trenutacno nalaze na Playlisti, spojit ¢e se jedna do druge u
jedan video sadrzaj.

e Opcijom Each Playlist Item svaki ubaceni video sadrzaj ¢e se
posebno izvest.

e Ako je mulimedijski sadrzaj pokrenut s kartice Playlist ili direktno
dodan u Viewer (Preglednik), on se nalazi u Source modu i
prikazuje se na ovoj listi kao zadnji odabir za izvoz.

Za vecinu korisnika je dovoljno odabrati samo jednu od ponudenih
opcija u izborniku Presets, te oznaditi u polju From $to se zeli
izvesti.

Ako se zeli podesiti uz osnovne postavke jos i neke naprednije,
potrebno je na dnu izbornika Export pritisnuti na dugme Advanced
kojim se otvara jo$ niz dodatnih postavka za izvoz multimedijskog
sadrzaja.

Format mp4

mpeg
Video
mpeglvideo

Fi~ rmrman teidan

U polju Format, prikazanom na gornjoj slici, moguce je odabrati u
padajuc¢em izborniku format video sadrzaja kojih ima vise od 60 u
ponudi. Mnogi se od njih ne koriste ¢esto, neki se koriste samo na
odredenim platformama, a ovdje Ce se opisati samo oni najzastupljeniji.

Video Codec Audio Other

Resolution 1920 5 x 1080 &

Na kartici Video, u prvom polju Resolution moguce je odabrati
rezoluciju izvezenoga video sadrzaja. Rezolucija se mozZe mijenjati
ruéno tako da se upisu vrijednosti za Sirinu i visinu slike ili automatski,
tako da se odabere s lijeve strane ve¢ unaprijed pripremljen predlozak.

Aspect ratio

U polju Aspect ratio moguce je odabrati omjer slike, a najéesce
koriStenisu16:9i4 : 3.

Framesfsec 50,000

Polje Frames/sec oznaCava frame rate ili frekvenciju, tj. brzinu kojom se
kadrovi (uzastopne slike) prikazuju na animiranom zaslonu, a izrazava
se kadrovima u sekundi (engl. frame per second, fps). Ovaj se izraz
koristi i za filmske i video kamere, raunalne grafike i sustave snimanja
pokreta (video nadzor). Najbolje ga je podesiti na vrijednost jednaku
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onoj originalnoga video sadrzaja jer se time brzina nece razlikovati u
odnosu na brzinu originalnoga video sadrzaja.

Interlaced

Scan mode  Progressive

U polju Scan mode moze se odabrati izmedu dvije vrijednosti,
Interlaced i Progressive.

o Kod Progressive prikaza slike (oznaCava se malim slovom "p",
npr. 1080p) prikazuje se, tj. iscrtava kadar po kadar, neovisno o
tome je li rije€ o televizoru ili monitoru koji je primjerice na 60 fps-
a, dobije se uvijek kompletnih 60 kadrova.

o Kod Interlaced prikaza slike (ozna¢ava se malim slovom "i", npr.
1080i), najjednostavnije reCeno je da dvije slike Cine jednu, {j.
slike su prepletene. To je izvedeno tako da se 50 % slike iscrtava
na ekranu, a drugih 50 % su laZne slike. Najbolje se to moze
vidjeti ako se zaustavi video sadrzaj, kod Interlanced ("i") slika
¢e biti mutna, a kod Progressive ("p") slika je Citava u
potpunosti. Po kvaliteti HD standarda, kvaliteta video zapisa ide
sljedec¢im redoslijedom: 1080p, 720p, 1080i, 720i, a sve ispod
toga nije pravi HD standard.

Field order Mone -

Deinterlacer  YADIF - temporal + spatial =

Interpolation  Bilinear (good) bl

Kada se odabere Interlaced u Scan modeu omoguceno je u polju Field
order odabrati opciju Bottom Field First ili Top Field First kojom se
odreduje s koje ¢e se strane slika popunjavati, gornje ili donje. Ako je
odabrana naredba Progressive u Scan modeu, omogucen je u polju
Deinterlacer odabir algoritma po kojem ¢e se video obradivati. Najbolji
odabir je YADIF — temporal + spatial.

U polju Interpolation moguce je odabrati jednu od Cetiri ponudene
naredbe. Odabirom neke od tih naredba moguce je postiéi vecu ili manju
fluidnost video sadrzaja.

Video Codec Audio Other

Codec  libx264

Na drugoj kartici Codec u polju Codec odabran je ve¢ codec koji
najbolje odgovara postavkama video sadrzaja. Moguce je odabrati i neki
drugi codec s popisa, ali preporucljivo je koristiti ponudeni koji se mijenja
ovisno o odabranom predlo$ku formata video sadrzaja (lijeva strana
dijaloSkog okvira Export).
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Average Bitrate

Constant Bitrate
Rate control  Quality-based VER

Constrained VER

Dosta bitno polje je i Rate control u kojem je moguce odabrati iz
padajuceg izbornika jednu od Cetiri mogucnosti: Average Bitrate,
Constant Bitrate, Quality-based VBR i Constrained VBR.

e CBR (Constant BitRate) kodiranje zadrzava isti broj bitova u
sekundi tijekom cijeloga procesa kodiranja. CBR kodiranje ne
optimizira video sadrZaj za kvalitetu ve¢ za ustedu prostora, tj.
konacan video sadrzaj ¢e biti maniji. CBR se koristi samo ako
video sadrzaj sadrzi sli¢nu razinu gibanja objekata tijekom
Citavoga trajanja video sadrzaja, a najceS¢e se koristi za
streaming video sadrzaja.

e VBR (Variable BitRate) se koristi za kodiranje promjenjive brzine
prijenosa, prilagodava se brzina prijenosa podataka prema donjoj
i gornjoj granici koja se postavi. To znaci da ¢e se tijekom
procesa kodiranja VBR video sadrzaj dinamicki povecavati ili
smanjivati, ovisno o potrebama video sadrzaja. VBR se duze
kodira, ali proizvodi povoljnije i kvalitetnije rezultate.

Kada je rije¢ o odabiru izmedu VBR ili CBR kodiranja, gotovo uvijek se
preporuca koristenje VBR kodiranja jer pruza kvalitetnije datoteke.
Preporuka je da se ne upotrebljava CBR osim ako postoji specifitna
potreba za, na primjer, reprodukcijom na uredaju koji podrzava samo
CBR. U konkretnom slucaju, optimalno je koristiti Quality-based VBR ili
Constrained VBR ako se Zeli ograniiti propusnost video sadrzaja.

Video Codec Audio Other

Sample rate 48000 * Hz

Codec aac -

Rate control  Average Bitrate -

Bitrate 384k * hfs

Disable audio

Na kartici Audio moguce je odabrati kvalitetu audio sadrzaja, codec i
Rate control. Kod audio sadrzaja sasvim je dovoljno koristiti Average
Bitrate u polju Rate control i Sample rate od 48000 Hz. Moguce je i
onemoguciti audio sadrzaj stavljanjem kvacice na opciju Disable audio.

Nakon podesSenih postavki, potrebno je samo pritisnuti na dugme Export
File nakon kojeg se otvara dijaloSki okvir Export File u kojem se odabire
mjesto spremanja video sadrzaja. Upisuje se samo naziv video sadrzaja
i pritisne na dugme Spremi.
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J|:||:|5 !
D:/Podacif1 ..Vjezba_8.mpd 31%

Pause =

History Jobs

Na kartici Jobs koja se dobiva ukljucivanjem dijaloSkog okvira History,
na desnom dijelu programa, prikazuje se informacija u kojem je statusu
izvezeni multimedijski sadrzaj. Tako se moze pojaviti poruka da izvoz
nije uspio, da je u procesu izvoza ili da je zavrSen. Kada je multimedijski
sadrzaj u procesu izvoza, ispisuje se postotak, tj. informacija o tome
koliko je jo§ potrebno do zavrSetka, kao $to je prikazano na gornjoj slici.
Ako izvoz nije uspio iz nekog razloga, ispisuje se poruka failed i
objasnjenje zasto se to dogodilo. Kada je uspjeSno izvezen multimedijski
sadrZaj, pojavljuje se poruka done, nakon koje se multimedijski sadrzaj
moze pregledati na spremljenom mjestu.
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7.2.

Vjezba: lzvoz video sadrzaja

Otvorite projekt iz prosle vjezbe naziva Projekt_4.mit.

Izvezite sve multimedijske sadrzaje koji se nalaze u kartici
Playlist tako da odaberete u polju From, opciju Playlist.
Odaberite predlozak YouTube, promijenite rezoluciju u
polju Resolution na 1920 x 1080 i u polju Frame/sec
postavite vrijednost na 30. Pritisnite dugme Export File i
spremite video sadrzaj pod nazivom

Projekt_4-playlist.

Izvezite Timeline tako da pritisnete dugme Export.
Odaberite predlozak H.264 High Profile, promijenite
rezoluciju u polju Resolution na 1920 x 1080 i u polju
Frame/sec postavite vrijednost na 50. Pritisnite dugme
Export File i spremite video sadrzaj pod nazivom
Projekt_4-H264_50p.

Izvezite Timeline tako da pritisnete dugme Export.
Odaberite predlozak H.264 High Profile, promijenite
rezoluciju u polju Resolution na 1920 x 1080, u polju
Frame/sec postavite vrijednost na 50 i na kartici Codec
postavite polje Quality na 50 %. Pritisnite dugme Export
File i spremite video sadrzaj pod nazivom Projekt_4-
H264_50p-Q50.

. ZapiSite veli€inu pojedine datoteke u MB:

e Projekt_4-H264_50p.mp4:

e Projekt_4-H264 50p-Q50.mp4:
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8.Vjezba: Obrada snimljenog
videosadrzaja

U ovom zavr$nom zadatku obradit ¢e se snimljeni sadrzaj iz OBS
Studija u programu Shotcut. U programu Shotcut radit e se montaza
snimljenog videosadrzaja, u kojoj ¢e se obrisati nepotrebni dijelovi,
dodati pozadinska glazba, dodati prijelazi izmedu slajdova i na kraju
izvesti videosadrzaj. Cilj zadatka je pomocu dvaju alata dobiti kvalitetan i
dinami¢an konacan videosadrza;.

8.1.

1.

Vjezba: Montaza videosadrzaja

Umetnite sljede¢a dva multimedijska sadrZaja u program
Shotcut u Playlist. Suncev_sustav.mp4,
Dexter_Britain_-_06_-_Summers_Coming.mp3.

Ubacite u Timeline videozapis Suncev_sustav.mp4, i
promijenite naziv videotrake iz ,V1“ u ,Video sadrzaj"“.

Ako videozapis Suncev_sustav.mp4 nema razdvojen
audio od videa svaki u svojoj traci, potrebno je odabrati taj
videosadrzaj u Timelineu, pritisnuti desnu tipku misa i
odabrati naredbu More > Detach Audio kako bi se
razdvojio video od zvuka. Promijenite naziv audiotrake iz
,A1“u ,Audio sadrzaj"“.

Odrezite videozapis Suncev_sustav.mp4 na svakom
zavrSetku slajda pomoc¢u naredbe Split At Playhead. Na
kraju je potrebno imati 12 zasebnih videoisjeCaka, pri
¢emu svaki od njih predstavlja jedan slajd prezentacije.

Obrisite videoisje€ak planeta Pluton i njegov
audiosadrzaj, kao i visak scene s kamerom koji se nalazi
na zadnjem slajdu. Svaki video- i audiosadrzaj potrebno
je pomaknuti do prethodnog tako da nema prekida
izmedu video- i audiosadrzaja.

Izmedu svih videoisjeCaka napravite prijelaz Dissolve u
trajanju od 1 sekunde.

Podesite audiosadrzaj tako da odgovara videosadrzaju.

Dodajte novu audiotraku u Timeline, promijenite joj naziv
u ,Pozadinska glazba“ te ubacite u nju audiosadrzaj
Dexter Britain — 06 — Summers Coming.mp3.
Poravnajte audiosadrzaj da po¢ne od pocletka, odrezite
ga do duljine trajanja posljednjeg videoisjeCka te obriSite
ostatak.

Na svakom mjestu gdje se Cita naziv planeta / zvijezde i
kratka zanimljivost potrebno je pomocu keyframeova
postaviti na pozadinsku glazbu filtar Gain / Volume i
smanijiti glasnocCu pozadinske glazbe na -20 dB kako bi

Trajanje
poglavija:

40 min

Zanimljivosti i napomene

Prilikom umetanja prijelaza
Dissolve moguce je da se
pomakne audio- od
videosadrzaja, pa je
potrebno i njega korigirati
rezanjem i premjeStanjem
na to¢no odreden slajd.
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10.

11.

12.

13.

se glasnije Culo Citanje, a pozadinska glazba bila utiSana
na tom mjestu.

Napravite postupno prikazivanje prvoga videoisjeCka u
trajanju od 2 sekunde i postupno nestajanje zadnjega
videoisje€ka u trajanju od 2 sekunde.

Postupno pojacajte zvuk na po€etku zvuéne datoteke
Dexter Britain — 06 — Summers Coming.mp3 i postupno
smanijite zvuk na kraju iste zvu¢ne datoteke u trajanju od
dvije sekunde.

Spremite projekt pod nazivom Suncev_sustav.mlt i
pregledajte cijeli sadrzaj.

Izvezite Timeline tako da pritisnete Export. Odaberite
predloZzak H.264 High Profile, promijenite rezoluciju u
polju Resolution na 1920 x 1080 i u polju Frame/sec
postavite vrijednost na 30. Pritisnite Export File i
spremite videosadrzaj pod nazivom Suncev_sustav-
finalna_verzija.mp4.
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